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Getting Started

This manual assumes that you are somewhat familiar with the Macintosh. We assume that TFCalc already hag been
installed on your computer’s hard disk. A screen similar to the one shown below should appear.

" ® File Edit s Labsi Special

TFCalc Disk
T itemns E20K in dizk

Ky

TFCale-HS Substrates f

b

TFCale Materials f

Coatings Murninantz f

Detectors f

The icon with the name “TFCalc” below it represents the TFCalc thin film design program. The disk also contains
five databases of information about various coating materials (such as MGF2, SIO2, and T102), substrates (sych as
GLASS, AIR, and BK?7), illuminants, detectors, and radiation distributions. The folder labelled Coatings holds T
several sample coating designs. You may open the folders and view their contents by double-clicking on a folder.

To start the program, move the cursor on top of the TFCalc icon and click the mouse button twice (with a very short
delay between the clicks). The program will start to load all the information it needs to operate.

Each copy of TFCalc has a unique serial number. If the serial number is less thathd®b#ie following dialog
will appear the first time you run TFCalc:

Enter TFCalc Access Code

TFCalc cannot be used until the access code is entered below.

TFCalc serial number: 100 TFCalc version: 3.4

Please enter the 9-digit access code that was sent with this
copy of TFCalc. The company name will appear on printouts.

Company name: | |

[ oK | [ EsitiFcaic | [Run as Demo

The 9-digit access code is attached to the sleeve holding the TFCalc CD-ROM. Just enter the 9-digit code and click
OK. Unless you install TFCalc in multiple directories or on multiple computers (or you subsequently run an old
version of TFCalc), you should see this dialog only once.
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Using theMenus

Shown below is an example of TFCalc’s “menu bar”, which is the primary means of telling the

" % File Edit Modify R Results  Misc. 0Options
Analyze Dnly #A
Optimize Design L
Global Search 6
Compute EFI #E
Compute Sensitivity

Compute Cone-Angle Average
Compute Monitor Curve EM

Set Analysis Parameters...
Set Optimization Parameters.
Set Global Search Parameters
Set EFI Parameters...

Set Sensitivity Parameters...
Set Cone-Angle Parameters...
Set Monitoring Parameters

program what to do. Along the top of the screen are the names of the menu choices. To see the selections available
under each menu, move the cursor to one of the names in the menu bar, and press (and hold down) the mouse
button. To select an item from a menu, move the cursor to the item and release the mouse button.

Note that some items in a menu are followed by3gie  symbol and a letter. Those items, which tend to be used

quite frequently, may be selected from the keyboard by holding down the “commani3gey” ( onathe
keyboard) and pressing the appropriate letter.
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Editing Data Windows

The figure below shows what we call a “data window.” These “windows” are the primary method of displaying and
editing data about a coating design.

SOE—————— Front Layers

Layer 1 2 3 4
Material Tioz2 sloz Tioz2 S0z
00T 0.5531 0.5973 0.8523 01274
Thickness {nm} 2091 §4.50 49.14 12.04
Optimize? Yeg es es Yeg
Group 1 1 1 1
Constrain? Mo Mo Mo Mo
Min. Thickness | 0.0000 nm [ 0.0000 nm | 0.0000 nm | 0.0000 nm
Max. Thickness | 0.0000 nm | 0.0000 nm | 0.0000 nm | 0.0000 nm
MNeedles? Yes Yes Yes Yes

This figure shows how the data about layers is displayed. Note that only four layers are shown here. However, it is
easy to move to the other layers:

 To move one layer at a time, move the cursor to one of the “scroll arrow” boxes in the bottom corners, and click
the mouse button.

» To move five layers at a time, click the mouse after moving the cursor into the area between the scroll arrows at
the bottom of the layer window.

* To quickly move to any section of five contiguous layers, move the cursor to the “scroll” box (somewhere
between the arrow boxes), press the mouse button, and, while continuing to hold down the button, move the
cursor to a new location. The scroll box will be “dragged” along. When you release the mouse button, the
position of the scroll box determines which layers will be displayed.

» To display fewer or more layers at one time, the size of the window can be changed by dragging the “grow” box
in the bottom right corner of the window.

To modify layer data, just move the cursor to the box you wish to change, and click the mouse button. The box will
reverse color. Type the new data. Numbers may be entered with an exponent: 3.14e-5 means 0.0000314. If you
make a mistake, the program will notify you. When you are done making a changes to a box, there are several ways
to tell TFCalc that you are done:

»  Click the cursor in another box
» Press the Tab key, which selects the box to the right

» Press the Return key, which selects the next box down (or Shift-Return to go up)
* Press the Enter key, which stops editing in the window

On your computer screen, you will note that the top-most (or “active”) window is the window that may be edited.
You can make a window active by moving the cursor to it and clicking the mouse. You can make a window
disappear by clicking the mouse inside the close box in the upper right corner.

Also note that when a window is active, the Options menu will display menu choices that are unique to that window.
In particular, this menu allows you to add, delete, or print the data in the window.
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Editing Dialogs

The figure below shows an example of what is called a “dialog.” Dialogs are useful for entering small amounts of
data.

wavelength {nm):
Layers: CAl I:I to

Resolution: O Llow O Medium @ High
(] Compute Intensity in Incident Medium

[ Compute Intensity in Substrate

[[ 0K ]] [ Cancel ]

This dialog is for selecting how the electric field intensity should be computed. It contains four types of inputs:

* The boxes containing numbers are called “text boxes.” You may move from one to another by pressing the Tab
key or by clicking the mouse on the desired box.

e The circles in front of Low, Medium, and High are examples of “radio buttons.” Point and click the mouse at
the desired choice. Clicking on the text to the right of the circle also selects the radio button.

» The two marked squares are called “check boxes.” They are used for yes-no inputs. Point and click the mouse
on a check box to change its state. Clicking on the text to the right of the box also selects or deselects the check
box.

» The two rounded rectangles at the bottom of the dialog are called “buttons.” After changing any of the data in
the dialog, you should click on the OK button to save the data, or on the Cancel button to disregard the data.
Note that an outline around the OK button indicates that this is the default button. On any dialog, you may
select the default button by pressing the Return or Enter keys. If a dialog has a Cancel button, a fast way to
select it is to press the ESC key or to type command-period (that is, hold down the command key and press
period).

Another type of input is illustrated in the Table Parameters dialog shown below.

Display: [ Reflectance +| O de
Polarization: [ Average are Os
[ Show Saved Results: @1 2 O3 O4 05

Here, the box containing the down-arrow symbol is called a “pop-up menu.” By clicking the mouse in this box and
holding down the mouse button, a list of choices will be displayed, as shown below.

+ Reflectance

Transmittance
Absorptance
[ Show Saved| Loss

Optical Density
C Psi
Phase Shift on Reflection
Phase Shift on Transmission

Polarization:

To select an item from the list, move the mouse to the item and release the mouse button.
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Configuring TFCalc

TFCalc allows coating designers to configure some aspects of the program to suit their needs. The configuratipn
dialog is shown below.

wavelength unit: @nm Opm O#
Accuracy of results: O2 O3 D4 O95 @6
Thickness priority: @ Optical (O Physical
Phase convention: O Muller (@ Abelés

Color ohserver: @ 2° field ) 10° field

[ Display OWOT for absorbing materials also

[ Allow tabular data to to extrapolated

[1Allow materials to have gain (K < 0)

Specifically, the user may

» Change the units used for wavelengths. All wavelengths will be displayed using the selected units.

» Change the accuracy of the displayed results. An accuracy of “4” means there are 4 digits to the right of the
decimal point in all values displayed — a total of six digits.

« Indicate whether priority is given to optical or physical thickness. If the thickness priority is set to “Optical”,
then the optical thickness of layers remains constant when the reference wavelength or index of refraction is
changed. If the priority is “Physical,” then the physical thickness remains constant.

« Change the phase shift convention. There are two conventions for computing the P polarization of phase shift
on reflection. Using the Muller convention, the S and P polarizations always differ by 180° at normal incidence.
Using the Abelés convention, the S and P polarizations are the same at normal incidence.

» Change the field of view of the standard color observer. Select either 2° or 10°.

» Change how the QWOT (quarter-wave optical thickness) of absorbing materials is displayed in the Layers
windows. In the past, TFCalc displayed “n/a” for layers composed of an absorbing material. If the user selects
this option, the quantity 4 d r\j is displayed, where d is the physical thickness of the layer and n is the real
part of the refractive index at the reference wavelehgth

* Indicate whether data tables should be extrapolated. If this is checked, then when a wavelength is outside of the
range of wavelengths in the data table, TFCalc will use the value at the closest endpoint. If this is not checked,
then TFCalc will warn the user when a wavelength is not within the range of data in a table.

* Indicate whether coating materials are allowed to have gain, which is the same as a negative extinction
coefficient (k < 0) in TFCalc.

These configuration settings are stored on the disk and read each time the user starts the program.
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Intr oduction

The flow diagram shown below expresses, in general, how to use the TFCalc program to design a thin film coating.
Let’s see how the diagram translates into actions taken by the designer.

open coating
file
modify coating display
design results
optimize print
coating results

Y

analyze close coating
coating file

The process begins by opening a new or existing coating file (by selecting New or Open from the File menu). Next,
the designer modifies the coating design (by selecting from the Modify menu). Then the designer may optimize and/
or analyze the coating (by selecting from the Run menu). Now the results are viewed (by selecting from the Results
menu). The designer prints some results (by selecting from the Options menu while the results are displayed on the
screen). Finally, the coating design is saved for future reference (by selecting Save and then Close from the File
menu).

Although this is only one scenario, it shows how easy it is to use the program. Designers become familiar with the
program in just a matter of minutes, allowing them to focus their full attention on the design problem — instead of
the operation of the computer.



Section 2 Guide to TFCalc Page 3

The Model

The diagram below details the physical system modeled by TFCalc.

Front Back
I~ exit
/Um’”an[ 7 medium
g
@
incident =
medium @

* * layer 1

The illuminant, stored in the llluminant database, is given as a table of spectral intensity versus wavelength. The
incident angle may vary from 0 to 89.999 degrees. The substrate and the incident and exit mediums are selected
from the Substrate database. The detector, given as a table of efficiency versus wavelength, is selected from the
Detector database. The thickness of the substrate, which is considered a massive layer, may be specified. Note that
the substrate could be, for example, air. Both the substrate and the exit mediums may be absorbing materials. The
materials that compose the front and back layers are selected from the Materials database (or from a name in the
Variable Materials window). Currently, there is a limit of 5000 layers. The optical properties of substrates and
materials are stored as tables or dispersion formulas of complex refractive index (n-ik) versus wavelength.

It is now possible to specify which surface the light encounters first: Front or Back. That is, light can come fro
either side of the coating. See the Environment Dialog (page 10) for more details.

Note that layer 1 is next to the substrate.
Note: If the substrate and the exit media are different (or if there are back layers), reflections due to the back |

surface of the substrate will be computed. If you wish to avoid this result, the exit medium must be the same
as the substrate and there must be no back layers. |
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Capabilities

The TFCalc program enables you to analyze and design multilayer thin film coatingsofStenfeatures are:

» Reflectance, transmittance, absorptance, optical density, loss, color, luminance, psi, phase shift on reflection or
transmission, and electric field intensity may be computed and plotted.

* The sensitivity of the coating to manufacturing errors may be analyzed. Optimization can be used to minimize
the sensitivity. Layer sensitivity can be computed and displayed.

» A coating can be analyzed for a cone of angles (as in a convergent beam of light) and a user-defined radi1tion
distribution.

» The coating materials, the substrate, and the exit medium may be dispersive and absorbing; the incident medium
may be dispersive. Dispersion formulas can be used to give the index of materials and substrates.

* The refractive index (n and k) of a substrate or layer can be determined from measured data.

» The illuminant may be specified. The reflectance or transmittance of a thin film may be stored as an illuminant,
so that the output of one filter can be made the input of another. Also, blackbody illuminants may be created.

» A detector function may be specified.

e The substrate may have a finite thickness; reflectance and transmittance calculations take into account the back
surface of the substrate and any attenuation within the substrate.

» A coating may have up to 5000 layers, composed of up to 150 different materials.
» “Stacks” of layers may be entered using a formula, such as H(LH)"5.

» Layers may be arranged in groups, and the groups may be optimized.

» The index (n and k) and thickness of a layer can be optimized.

« Layers on both sides of the substrate may be optimized simultaneously. During optimization, the layer
thicknesses can be constrained to be between a minimum and a maximum value.

» Global search may be used to locate the best design, rather than just the local minimum.
* Up to 5000 optimization targets may be specified. Also, a target can be an inequality, such as < 10% or > p0%.
»  Multiple environments can be used to develop, for example, coatings for multiple substrates.

* Needle optimization can add layers to a design automatically, which is very useful if the design’s requirements
are unusual. The tunneling method can be used to automatically generate a sequence of optimal designs.

» Targets may be generated automatically. Also, targets may be read from files. Color and luminance targets can
be generated.

« First, second, and third derivatives (with respect to wavelength or wave number) may be used as targets.

e The equivalent index may be calculated. Also a layer may be replaced by an equivalent (HLH)*p or (LHL)"p
stack which matches the layer’s index.

» A choice of three local optimization methods are available: Gradient, Variable Metric, or Simplex.
» Data for an unlimited number of materials, substrates, illuminants, detectors, and distributions may be entgred.

* The results of six thin film calculations may be compared by plotting them on the same graph. Different types
of plots may be overlaid: e.g., reflectance and transmittance.

* The minimum, maximum, and average values of a parameter (e.g., reflectance) can be computed for a range of
wavelengths.

»  Optical monitoring curves can be computed and plotted.
* Results may be saved to text files for processing by other software.
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File Menu

New Coating 3N
Open Coating...
Reopen Coating b

Page Setup: Text...
Page Setup: Plot...

Quit TFCalc #®0

Use this menu to read, write, or print coating files. Below we briefly describe each menu item.

New Coatingis for starting a coating file from scratch. If there is a coating file called DEFAULT in the same folder
as the TFCalc program, then that coating file will be read. Shortcut: Command-N.

Open Coatingis for reading an existing coating file from the disk. The program will display the name of each
coating file and wait for you to select one. This is the standard Macintosh dialog for selecting a file. When TFCalc
begins, it displays this dialog. An example of the open coating dialog is shown below. Shortcut: Command-O.

— TFCalc lolume
B 4-Layer AR
i) 4-Layer AR monitor test
Bhl 4-Layer AR monitor test 2
@ 4-Layer AR test [ e
B 4-Layer AR, 2 sided
B 4-Layer AR, greenish
P 4-Layer AR, greenish, se. I Open I

Click the mouse on the name of the file you want to read, and then click the Open button.

Reopen Coatingis used to open a file that has been used before. TFCalc keeps track of the last 20 coating degigns
opened by the user. These files are displayed in a menu when the user selects this command.

Close Coatingtells the computer that you are finished with the coating on which you are currently working. If you
have not saved the file, the program will ask if you wish to do so.

Save Coatingis used to save the coating on which you are working. After a coating has been saved, you may
continue working on it. It is a good practice to occasionally save a coating while you are working on it; if you suffer
a loss of power, this practice will save your data. Shortcut: Command-S.
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Save Coating Ads for saving a coating under a new name. You are asked for the new name. This command is
useful when you want to work with (or experiment on) several similar coatings. This is the standard Macintosh
dialog for saving a file. An example of this dialog is shown below.

=] Test Cases ¥

. auar AR
gy HE moanitar fasd

Eipnt

I
=
[l
&
[x]
g
=
3
1]

L

43 iH

4-faner B85 moniier fasl 2 Desktop

G-iayur #H fast
______ 4-fagey #H, Jsitled
Save this coating as:
untited ___|

Revert to Original is for going back to the previous copy of this coating: i.e., the coating you started with an Open
command, or the coating you lasted Saved. This command may be useful if you make changes to a coating, and the
new coating is not as good as the previous one.

Print Coating prints the current coating design on the printer. You must choose the quality of the printout using the
dialog shown below. This is the standard Macintosh printing dialog for the LaserWriter printer. This dialog is
slightly different for other types of printers.

LaserlWriter “LaserlWriter” 71z ﬁwint

Copies:m Pages: @ Al From: To:
Cancel

Cover Page: ® No ) First Page O Last Page

Paper Source: @ Paper Cassette (O Manual Feed

Print: @ Black & White () Color/Grayscale

Destination: (@ Printer ) PostScript® File

Page Setup: Texenables you to specify how text should be printed. You will see a dialog for configuring your
printer, such as shown below. Note that each type of printer has a different printer setup dialog.

Laserllriter Page Setup 71z |m|
Paper: @ US Letter (J A4 Letter _ ———
(O US Legal () B5 Letter —*[_Tabloid ¥] (cancel |
Reduce or Printer Effects:
[100 3
Enlarge: & Font Substitution?
Orientation [ Text Smoothing?
[ Graphics Smoothing?
(] Faster Bitmap Printing?

Page Setup: Ploenables you to specify how plots should be printed. You will be presented with a dialog for
configuring your printer, such as shown above. TFCalc provides for separate page setups to text and graphics
because they are frequently printed in different orientations.

Quit stops the program. If the current coating has not been saved, you are asked whether you want to save it.
Shortcut: Command-Q.
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Edit Menu

| Eait I

Undo 37
Cut #H
Copy #C
Paste D

The menu shows the standard Macintosh menu items for editing text. You may use these commands to edit text that
you have entered. Below we briefly describe each menu item.

Undo is not enabled in this program at this time. If you make an error, this menu item cannot help you!
Cut is for removing text you have selected. The text is put in the paste buffer.
Copy is for making a copy of the text you have selected. The text is put in the paste buffer.

Pastecauses the contents of the paste buffer to be inserted at the current cursor position.
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Options Menu

Add Front Layers...

m Delete Front Layers...

Print Front Layers...
Copy Front Layers from...
Append Front Layers from...

Reverse Front Layers
Adjust Front Layers for Angle...
Consolidate Front Layers

Compute Equivalent IndeH...

Compute Equivalent Stack... ) ) ) )
Show Thickness Totals... This menu displays options available when a

particular window (e.g., Layers, Targets, Plot)
is the active window. Below we briefly describe
the first five menu items. Because Option 1,
Option 2, and Option 3 are customized for each
window, consult the appropriate section of this
manual for more details.

Read Layer Data from File...
Save Layer Data in File...
Save Layer Data in Clipboard

Substitute Layer Data...

Add allows you to increase the number of
entries in the active window. For example, to increase the number of front layers in your coating, first select the
Front Layers window and then select this menu item. The Add dialog is illustrated below.

Current number of front layers: 3

add [ storting at

Deleteallows you to decrease the number of entries in the active window. For example, to decrease the number of
front layers in your coating, first select the Front Layers window and then select this menu item. The Delete dialog
is shown below.

Current number of front layers: 3

Delete through

Print allows you to print the contents of the active window. For example, to print the layer data, first select the
Front Layers window and then select this menu item.

Copy andAppend allow you to copy information from an existing coating file to the current coating. After this
command is selected, the standard dialog for selecting a file will appear.
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Modify Menu

Modify Use this menu to display and change the coating data. Below we briefly
y describe each menu item. All of these items are covered in greater detail on
subsequent pages.

Environment...

Stack Formula...
Layers - Front
Layers - Back
Groups

Targets - Discrete
Targets - Continuous
Comments

lariable Materials
Environments

Environment causes the environment dialog to appear.
Stack Formula causes the stack formula dialog to appear.

Layers - Front displays the data about the layers on the front side of the
substrate.

Layers - Backdisplays the data about the layers on the back side of the
substrate. There may be a total of up to 5000 layers on both sides

Materials .

Substrates (combined) of the substrate.

IHluminants . . .

Detectors Groups displays the data on the groups. This option enables us to treat

groups of layers in a uniform way. For example, after putting the odd-
numbered layers in group 1 and the even layers in group 2, we could easily
increase the thickness of the layers in group 1 by 10%. There may be up to
5000 groups.

Distributions

Targets - Discretedisplays the discrete targets used to optimize a coating. A discrete target is an optimization target
at a single wavelength. The program aids you in designing a coating with the specified reflectance, transmittance,
absorptance, psi, density, color, luminance, or phase shift at up to 5000 targets. |

Targets - Continuousdisplays the continuous targets used to optimize a coating. A continuous target is an
optimization target for a range of wavelengths. There may be up to 100 continuous targets.

Commentsdisplays the comments about this coating. Up to 22 lines of comments may be entered.
Variable Materials displays the list of up to 150 materials whose index is allowed to vary.
Environments displays up to 10 environments that may be used during optimization.

Materials lets you display and modify the optical data for any number of coating materials. The names of materials
are displayed in alphabetical order.

Substrateslets you display and modify the optical data for any number of substrates. The names of substrates are
displayed in alphabetical order. The data for the incident and exit mediums (e.g., AIR and WATER) are stored with
the substrates.

llluminants lets you display and modify data for any number of illuminants. The names of illuminants are displayed
in alphabetical order.

Detectorslets you display and modify data for any number of detectors. The names of detectors are displayed in
alphabetical order.

Distributions lets you display and modify data for any number of radiation distributions. The names of distributipns
are displayed in alphabetical order.
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Environment Dialog

When a new file is started or an existing file is

Coating name: Neutral read from the disk, the program displays the
Reference wavelength (nm): dialog shown here. This information is called
| Muminant: the coating environment. The quantities in this
iy Incigent angle (degi:[00____ ] dialog are briefly described:

incid ent |

rnediurm | Incident medium: [AIR

*Reference wavelength refers to the

S Tmckns:sisz::;? ?;ASS wavelength used to specify the quarter-wave
T— _ _ optical thickness of the layers. If you change
Exit medium: |BLASS the reference wavelength, and the program is
Bt medur Detector: | IDEAL configured to give priority to optical
First Surface: thickness, then the physical thickness of all

[[ oK ]] [Cancel ] [Hnalgsis Parameters...} Environment:El the |ayef3 will Change- Usually denOted}Qy

¢|[ncident medium is a name in the list of
substrates. This name must be defined before
it may be used. If it is an absorbing material, TFCalc warns the user and assumes k=0.

* llluminant is a name in the list of illuminants. This name must be defined before it may be used.
« As shown in the schematic, the incident angle is measured from a normal to the substrate.

e Substrate is a name in the list of substrates. This name must be defined before it may be used. The substrate is
treated as a massive (bulk) medium, which has no interference effect; only attenuation if it is an absorbing
material.

» Thickness is the physical thickness of the substrate, given in millimeters.

» Exit medium is a name in the list of substrates. This name must be defined before it may be used. If the
Substrate and the Exit mediums are the same (and there are no back layers), it means the substrate has infinite
thickness (with no reflections due to the back surface). If they are different, then multiple reflections are taken
into account. Also, when the Substrate and the Exit mediums are the same (and there are no back layers), the
computed transmittance is the transmittance into the substrate; if they are different, then the transmittance
through the substrate is computed.

» Detector is a name in the list of detectors. The name must be defined before it may be used. Specifying a
detector is useful when you are designing a filter for a detector, otherwise it is best to use IDEAL.

» First Surface is either Front or Back. “Front” indicates that light encounters the front layers first. “Back”
indicates that light comes from exit medium.

Select the OK button (or press the Return or Enter keys) when you are done entering the data. The Analysis
Parameters button leads to the Set Analysis Parameters dialog. If you select the Cancel button, any changes you
made will be ignored.

When more than one environment has been defined, then an environment can be selected using the Environment
pop-up menu. The selected environment is called the current environment. For more information, see the section
about the Environments Window (page 25).
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Stack Formula Dialog

Enter the formula. The substrate is to the left of the first layer.
{HL)"10 1]
5
[] []
Material TI02 5102
Thickness | 1.0000 qgw 1.0000 qw
Optimize? [No Mo
Group 1 1
[[Generate Layers ]] [ Cancel } [ Clear Formula ]

This dialog allows you to enter a stack using a formula. The formula, which may be up to 32000 characters long,
may contain up to 26 one-letter symbols, such as the L and H shown above. Use the “<<” and “>>" buttons for|
additional symbols. Note that the substrate is next to the first layer. The syntax of a stack formula is very simple:

* Any sequence of symbols may be placed next to each other, e.g., ABCCCBA.

* Symbols may be grouped using parentheses, e.g., (ABC).

e The right parenthesis must always be followed by a caret (*) and an integer, e.g., (ABCBA)*10.
« A multiplier may precede any symbol or group of layers, e.g., 1.2 (0.5 A B 0.5 C)*2.

» Group factors may be used: G1 (HL)*5 G2 (HL)"5 means the first ten layers are in group 1 and the second ten
layers are in group 2.

* Spaces may be used anywhere for clarity, e.g., (1.5 A 2.3 B 0.7 C)"5 (ABC)"2.

After you have entered the formula, the meaning of the symbols should be entered. For each symbol used in the
formula, you need to specify the material it represents, its thickness, whether the layer should be optimized, and to
which group it belongs. If the thickness priority (set in the configure dialog) is optical, then the thickness value is
assumed to be QWOT, otherwise physical thickness in nanometers. You may also follow the thickness by “qw” or
“nm” to indicate the thickness units.

If you plan to use groups, be sure to define them in the Groups window before entering the formula.

It is best to use the Tab key to move between the boxes.

When you select the Generate Layers button, the program uses the stack formula to change the contents of the Front
Layers window. If you select the Cancel button, no changes are made. If you have substantially changed the design

in the Layers windows, you may want to use the Clear Formula button to erase the stack formula so that you do not
accidentally replace the Front Layers with the stack formula.
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LayersWindows
S Front Layers
Layer 1 2 3 4
Material TIO2 Slo2 TI02 Sloz2
QwaT 0.5831 0.5973 08323 01274
Thickness {nm) 50.91 54.50 49.14 12.04
Optimize? Yes Yes Yes Yes
Group 1 1 1 1
Constrain? Mo Mo Mo Mo
Min. Thickness | ©.0000 nm | 00000 nm | 0.0000 nm | 9.0000 nm
Max. Thickness | 2.0000 nm | 0.0000 nm | 0.0000 nm | 9.0000 nm
MNeedles? Yes Yes Yes Yes

There are two Layer windows: front layers and back
layers. These windows show information about the
layers that make up the coating. For each layer, you must specify:

* The material, which must either be in the material database or be defined in the Variable Material window.

« Either the quarter-wave optical thickness or the physical thickness. Note that only one thickness needs be
entered for each layer; if the optical thickness is entered, then the physical thickness will be computed, and vice
versa. If a layer consists of a material having a significant absorption at the reference wavelength, it is not
possible to compute the usual quarter-wave optical thickness. In this case, the program displays either “n/a” or
an approximate value in the QWOT row. See the section about configuring TFCalc (section 1, page 6) for more
details.

*  Whether you want to optimize the layer.

» The group with which the layer is associated. If you plan to use groups, they should be defined first, using the
Groups window.

*  Whether you want to constrain the thickness of the layer.
*  The minimum and maximum thickness, given in either nanometers (nm) or quarter-wave optical thickness (qw).
*  Whether needle layers are allowed to be inserted in the layer during needle optimization. |

Add Front Layers...
Delete Front Layers...

Erint Erun: tauers--f- When the Layers window is the top-most window, you may use the Options menu
o ron dayers from... . . . . .
Aopend Front Layers from... to perform various operations. In addition to allowing you to add, delete, print,

copy, and append layers, this menu has ten other options, which are described next.
Reverse Front Layers

Adjust Front Layers for Angle...
Consolidate Front Layers

Compute Equiralent IndeH...
Compute Equiralent S$tack...
Show Thickness Totals...

Read Layer Data from File...
Save Layer Data in File...
Save Layer Data in Clipboard

Substitute Layer Data...
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Reverse Layerds a command that reverses the order of the layers. Also note that there is a command on the Misc
menu to swap the front and back layers.

Adjust Layers for Angle is a command that changes the thickness of all non-absorbing layers. The thickness is
changed so that the effective thickness at the new angle remains the same. The dialog is below. Note that this dialog
always begins with 0.0 for both angles. This feature is also called angle matching.

Current design is for anangle of degrees
Change design for an angle of degrees

Cancel

Consolidate Layersis a command that removes layers having zero thickness, which may occur after a coating
design has been optimized. Also, if there are adjacent layers of the same material and the same group, this command
will combine the layers.

Compute Equivalent Indexis a command that calculates the equivalent (Herpin) index of a range of layers. The
dialog for front layers is shown below.

Determine the equivalent index and thickness

of front layers _I through

at wavelength 550.0

at incident angle |30.0

Equivalent Index = 41866
Phase Thickness (deg) = 270.00

Calculate Cancel

The range of layers being analyzed must form a symmetric stack. That is, the thickness of the first layer must be the
same as the last layer, the thickness of the second layer must be the same as the next-to-the-last layer, etc. The
command computes the index and phase thickness (at normal incidence) of a layer that is equivalent to the range of
layers at the given wavelength and angle. Note that the equivalent index is undefined if the wavelength is inside a
“stop band” for the range of layers.
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Compute Equivalent Stackis a command that calculates an HLH or LHL stack that is equivalent to a given layer.
The dialog for front layers is shown below.

Replace front layer _I with an equivalent stack.
wWavelength: B
Incident angle: [30.0
Polarization: P [ ]
Stack type: @ (HLH)“p O (LHL)*p
where p = 1—|
where H=|T102 wWoT = 1.566841
where L = |MGF2 wWoT = 13833 ]
4 solutions were found
[[l:alculate]] [Heplace] [l:anl:el ]

If the incident angle is not 0, then the polarization must be selected; the equivalent stack will match only the selected
polarization. Select whether an HLH or LHL stack is desired. Enter the names of the materials to be used; they may
be in either the materials database or the Variable Materials window. When the Calculate button is selected, the
equivalent stacks are computed. There are actually an infinite number of solutions; we display the ones whose layers
have a phase thickness less than 360 degrees (4 QWOT at normal incidence). The arrow buttons may be used to
scroll through the solutions. The solutions are sorted by increasing thickness. (QWOTSs are given at the reference
wavelength.) If the Replace button is selected, the displayed solution will replace the given layer in the Layers
window.

Show Thickness Totalss a command for displaying the physical thickness of each material used in the coating and
the total physical thickness of all the layers. The thinnest layer is displayed at the bottom of the dialog. The dialog
for the front layers is shown below.

Thickness totals {in nm} for front layers

TiO2 537652
510z 34502
All Layers 1521.54

Thinnest layer: 1 {57.65 nm)

Read Layer Data from Fileis a command that reads a text file containing two columns: material name and
physical thickness (in nm). A standard dialog will ask the user for a file name. This is a simple way of reading a
coating design into TFCalc.

Save Layer Data in Fileis a command that writes the material name and physical thickness (in nm) of each layer to
a text file. This command may be useful in creating a run sheet for the coating. A standard dialog will ask the user
for a file name.
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Save Layer Data in Clipboardis a command that copies the material name and physical thickness (in nm) of each
layer to the clipboard. This command may be useful in creating a run sheet for the coating.

Substitute Layer Datais a command that enables the user to many data items quickly. The dialog, shown below,
works as follows: it finds all layers that match all the conditions in the first column, then it changes the fields of
those layers to the values given in the second column. If the first column is all blank, then it matches all layers. In
the first column, the QWOT and Thickness items can be inequalities, such as < 10.

If a layer matches Then change the
these values: following values:

Material: [T102 | [zro2 |
awoT: | | | |

Thickness (nm):

Optimize?

Group:

Constrain?

Min. Thickness:

Mas. Thickness:

Needles?

[JChange Front and Back Layers
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GroupsWindow

E[I=———————— Groups

Group 1 2

Factor 1.0000 1.0000

Optimize? Mo Mo

Constrain? Mo Mo

Min. Factor 0.0000 0.0000

Max. Factor 0.0000 0.0000

] B

The figure above shows how the group data is displayed. For each group, you must enter:

The group “Factor” — a number that multiplies the thickness of each layer in the given group. This factor

always starts at 1.0. The true thickness of a layer can be computed by taking the thickness in the Layers window
and multiplying it by the factor of that layer’s group.

»  Whether to allow the group factor to be changed during optimization.
»  Whether to constrain the group factor during optimization.

*  The minimum and maximum group factors, if constrain is “yes”.

Add Groups...
Delete Groups...

Print Groups...
Copy Groups from...
Append Groups from...

Normalize Groups
fption 2
fEnding 3

When the Groups window is the top-most window, you may use the Options menu to perform various operations. In
addition to allowing you to add, delete, print, copy, and append groups, this menu has another option:

Normalize Groupsis a command that multiplies the thickness of each layer by the group factor of the layer’'s
group, stores the product as the new thickness of the layer, and then sets all the group factors to 1.0. So, for example,

to increase the thickness of each layer in group 1 by 10%, we would change the factor of group 1 to 1.1 and then use
this command.
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Targets (Discete) Window

E0=——— Targets - Discrete

Target * 1 2 3 4
Kind Intensity Intensity Phase Phase
Refl/Tran Refl Refl Tran Refl
Polarization Ave P Dif Dif
Wavelength 500.0 550.0 G000 650.0
4ngle Q.0 Q.0 [eRe] Q.0
Target 0.0 < 10.0 180.0 0.0
Tolerance 1.0 1.0 1.0 1.0
Environment 1 1 1 1
=l [

The figure above shows how the data about the discrete optimization targets is displayed. Targets must be entered
before performing any optimization. For each discrete target, you must specify:

» Whether it is an intensity or a phase target by entering either | or P (there are also codes for color, luminance,
and derivative targets, but it is easier entering them using the Add Color Targets and Generate Derivative
Targets commands on the Option menu).

» The quantity the user wants to optimize. Commonly, it is reflection (R) or transmission (T). It can also be
absorption (A), psi (P), or density (D). The product of reflectance and transmittance can be entered also. Jpst
enter R*T, Rp*Ts, or Rs*Tp, where the p and s suffix indicates the polarization. If R*T is entered, then the
window’s polarization row can be used to select whether Rs*Ts, Rp*Tp, or Rave*Tave is optimized.

» The polarization of the target. Use P or S for the pure polarizations; A for average polarization; and D is fof the
difference P-S. For example, if the target is reflectance, then average polarization means 0.5*(Rp + Rs) ar|d the
difference is Abs(Rp - Rs).

e The target wavelength (in the units you have chosen with the Configure dialog)
e The incident angle (in degrees), measured in the medium in which the light originates |

» The target value, whose units depend on the type of target. Use percentage for intensity targets such as
reflectance and transmittance; angle in degrees for phase and psi targets. The product R*T is allowed to
between 0 and 100. Any target can be an “inequality” target; that is, the value may be preceded by “>” (orbr<"
to indicate that any result greater than (or less than) the target is acceptable.

» The tolerance. The inverse of the tolerance is usually called the weighting factor. See the merit function
(page 36) to determine how this tolerance is used. Although a tolerance of 1.0 generally works well, you may
decrease it to force the optimization method to reduce the difference between the target value and computed
value. Note that the tolerances are relative; if all the tolerances are the same, then the effect is the same as when
they are all 1.0.

» The environment. For typical coating designs, this value will be 1. However, if multiple environments have
been defined (see page 25), then you may enter the number of the environment here.
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When the Discrete Targets window is the top-most window, you may use the Options menu to add, delete, print,
copy, and append targets. There are also options to generate targets and to read targets from a file.

Add Targets...
Delete Targets...

Print Targets...
Copy Targets from...
Append Targets from...

Generate Targets...
Read Wavelength Targets from File...
Read Angle Targets from File...

Add Color Targets...
Generate Derivative Targets...

Generate Targetsis a command that enables you to create many similar targets. The dialog is shown below.

Enter Target Information:

Inten/Phase:

Refl/Tran:

Polarization: AvE

wavelengths: 400.0 to [700.0 | by [100 |
Angle: 0.0 Humber of targets: M
Target: 0.0 Tolerance: II
Enviranment: 1

@ Wavelength O Wave number

Space targets by:
P E H 3 Log of Wavelength

X Replace current targets [ ok | [ cancer )

Most of the items in the dialog are the same as in the target window. The target can be an “inequality” target; that is,
the value may be preceded by “>" (or “<”) to indicate that any result greater than (or less than) the target is
acceptable. Note that you may specify a range of wavelengths: a beginning wavelength, an ending wavelength, and
an increment. If you change the “Number of targets” item, the increment will be adjusted so that the given number
of targets is generated. The generated targets may be evenly spaced by wavelength, wave number, or the logarithm
of wavelength. The last two options may be useful for optimizing broadband designs. If the “Replace current
targets” check box is checked, then the generated targets will replace all the targets in the Targets window;
otherwise the generated targets will be appended to the current list of targets. If you do not wish to generate any
targets, select the Cancel button; otherwise choose OK.
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Read Wavelength Targets from Filds a command that enables you to read targets from a file. The dialog is
shown below.

Enter information about target file:

Inten/Phase:

Refl/Tran:

FPolarization: Ave
Angle: 0.0
Tolerance: 1.0

Environment: 1

Use every Dth data point
Adjustment factor:

[<] Replace current targets
wavelength units in file:  @®nm  Opm OR

l Get File l Cancel

Again, most of the items in the dialog are the same as in the Target window. The text file containing the targets may
begin with any number of lines of nonnumeric data (comments, for example). Subsequent lines of text must consist

of a wavelength and a target value. If the file contains more data points than you want to use as targets, you can
command TFCalc to read only a subset of the data. (Some spectrophotometers create files with data points spaced at
0.1 nm. In that case, you may want only every 10th, 20th, or 100th data point.) Each data point may also be

multiplied by an adjustment factor as it is read. If the “Replace current targets” check box is checked, then the

targets from the file will replace all the targets in the Target window; otherwise the targets will be appended to the
current list of targets. If you do not wish to read any targets, select the Cancel button; otherwise choose Get File.

Read Angle Targets from Fileis another command that enables you to read targets from a file. The dialog is very
similar to the one shown above; the only difference is that it asks for the wavelength instead of the angle. Each line
of the text file containing the targets must consist of an angle and a target value.

Add Color Targets is a command for adding color and luminance targets to the Targets window. The dialog below
shows all the color parameters.

Color Standard: @ CIE 1931 (x,y) (ICIE 1976 (u',1')
wWavelength Interval: @ 10 nm 5 nm

Target Type: @ Reflection ) Transmission
Polarization: @ Average OP (S

Angle:

Target Color (=) [03333 | Tolerance: [1.0

Target Color (yl 03333 Tolerance: [1.0

Target Luminance (E)  |> 0.0 Tolerance:

Enviranment: 1

[ Replace current targets

Most of the items in the dialog are the same as in the target window. Select either the CIE 1931 or the CIE 1976
standard. Color may be computed by selecting wavelengths spaced either every 10 nm or every 5 nm. Choosing the
latter may cause the optimization to take twice as long.

Note that if a design is optimized using color targets spaced every 10 nm, but the final design is analyzed with a 5
nm (or smaller) interval, then the color coordinates may differ slightly. If this result presents a problem, do a final
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optimization using color targets spaced by 5 nm.

Generate Derivative Targetss a command for adding derivative targets to the Targets window. The dialog is
shown below.

Enter Target Information:

Inten/Phase: Derivative: w1l 2 O3

Refl/Tran: . @ Wavelength
with respect to:

Folarization: Hye i Wave number

wavelengths: 400.0 to [Fo00 | by [10.0 |

Angle: 0.0 Number of targets: 31

Target: 0.0 Tolerance: 1.0

Enviranment: 1

@ Wavelength O Wavre number

Space targets by:
P 9 4 > Log of Wawrelength

[ Replace current targets [[ 0K ]] [ Cancel ]

Note that this dialog is exactly the same as the “Generate Targets” dialog, except for the derivative information in
the upper right corner.
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Targets (Continuous)Window

E[J=—————== Targets - Continuous
Target * 1 2
Kind Intensity Intensity
Refl/Tran Refl Refl
FPolarization Ave Ave
wavelength (begin) S00.0 F00.0
wavalength (end) 550.0 10030.0
Angle 0.0 0.0
Target (begin} 1.0 > 98.0
Target {end) < 1.0 > 38.0
Tolerance 1.0 1.0
Environment 1 1

] [o]f

The figure above shows the data about the continuous optimization targets. Either discrete or continuous targets
must be entered before performing any optimization. For each continuous target, you must specify:

* Whether it is an intensity or a phase target by entering either | or P.

e The quantity the user wants to optimize. Commonly, it is reflection (R) or transmission (T). It can also be
absorption (A), psi (P), or density (D). The product of reflectance and transmittance can be entered also. Jpst
enter R*T, Rp*Ts, or Rs*Tp, where the p and s suffix indicates the polarization. If R*T is entered, then the
window’s polarization row can be used to select whether Rs*Ts, Rp*Tp, or Rave*Tave is optimized.

» The polarization of the target. Use P or S for the pure polarizations; A for average polarization; and D is fof the
difference P-S. For example, if the target is reflectance, then average polarization means 0.5*(Rp + Rs) ar|d the
difference is Abs(Rp - Rs).

* The beginning and ending wavelengths (in the units you have chosen with the Configure dialog)
* Theincident angle (in degrees), measured in the medium in which the light originates |

* The beginning and ending target values, whose units depend on the type of target. Use percentage for intensity
targets such as reflectance and transmittance; angle in degrees for phase and psi targets. The product R*T is
allowed to be between 0 and 100. Any target can be an “inequality” target; that is, the value may be precec[ed by
“>" (or “<") to indicate that any result greater than (or less than) the target is acceptable.

* The tolerance. The inverse of the tolerance is usually called the weighting factor. See the merit function
(page 36) to determine how this tolerance is used. Although a tolerance of 1.0 generally works well, you may
decrease it to force the optimization method to reduce the difference between the target value and computed
value. Note that the tolerances are relative; if all the tolerances are the same, then the effect is the same as when
they are all 1.0.

e The environment. For typical coating designs, this value will be 1. However, if multiple environments have
been defined (see page 25), then you may enter the number of the environment here.
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Add Continuous Targets...
Delete Continuous Targets...

Print Continuous Targets...
Copy Continuous Targets from...

Append Continuous Targets from...

antion §
fnbing 7
fnking 3

When the Continuous Targets window is the top-most window, you may use the
Options menu to add, delete, print, copy, and append targets.

Note: Be careful mixing discrete and continuous targets; if the tolerances are
the same, then each discrete target has the same weight as a continuous
target.
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CommentsWindow

[I=————— Comments
21-layer, TIOZ-SI0Z coating.

It makes a fairly good mirraor.

[

You may edit the comments by clicking the mouse inside the Comments window. To begin adding text at a certain
location, click the mouse at that location. To end your editing, press the Enter key or click the mouse in another
window. These comments are saved in the coating file.

The text on the first line of the Comments window will be displayed as a “remark” on some windows and printouts.
When the Comments window is the top-most window, you may use the Options menu to copy or append comments
from another coating file or to print the comments.

| Options

HEE I
pipip..

Print Comments...
Copy Comments from...
Append Comments from...

ipting §
B tinn 2
Hptinn ¥
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Variable Materials Window

S I=————— llariable Materials
Material * 1 2

Hame E C

Index M 1.86200 23000

Index K 0.0000 0.0000
Minimum N 1.3800 1.2800
Maximum N 27000 27000
Optimize N¥ es Yeg
Minimum K 0.0000 0.0000
Maximum K 0.0000 0.0000
Optimize K¥ Mo Mo

] =

The figure above shows how the data about variable materials is displayed. Variable materials, unlike the materials
in the materials database, are part of the coating design; that is, you may have different variable materials for each
coating. You may use the name of a variable material wherever a material name can be used. For each variable
material, you must specify:

» The name of the variable material. Each variable material must have a unique name. Also, the name may not be
the same as a material in the material database. To use a variable material in a layer, just enter its name in the
Material row of a Layer window.

e The initial index (N and K) of the variable material.

*  The minimum and maximum index (N) that the variable material may have. These limits are enforced only
when the variable material is being optimized.

*  Whether the optimization method should vary the index (N) of the variable material.

e The minimum and maximum index (K) that the variable material may have. These limits are enforced only
when the variable material is being optimized.

«  Whether the optimization method should vary the index (K) of the variable material.

Note: the index is not varied by the Simplex optimization method.

When the Variable Materials window is the top-most window, you may use the Options menu to add, delete, print,
copy, and append variable materials.

Variable materials are useful for experimenting with rugate or graded-index coatings — that is, coatings consisting
of two materials whose mixture is varied as the coating is produced. This type of coating may be simulated by a
number of thin layers, each having an index slightly different from the previous one. For example, to simulate a
coating whose index varies linearly (with thickness) from 1.5 to 2.5, you could enter 11 variable materials with
indices 1.5, 1.6, 1.7,..., 2.5 and then use those materials in 11 layers of equal thickness in the Front Layers window.

Variable materials can also be used to determine the index of unknown layers. In this case, the optimization targets
would be replaced by spectrophotometric or ellipsometric data. See Appendix C (page 63) for details.

Another use of variable materials is to find the ideal index of one or more layers; then the equivalent stack
computation could be used to replace the variable material layer with a stack of HLH or LHL layers (see page 14).
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EnvironmentsWindow

E=—————— [nvironments ————— The figure here shows how the data about
Environment # 1* 2 environments is displayed. Note that the current
11Tuminant ‘WwHITE ‘wHITE : H : : H
Troident Hediom R R enwronme_nt, which is gsed when_a cpatlng is
Substrate — GLASS GLASS analyzed, is marked with an asterisk in the top row.
Thickness {mm 1.0 1.0 : . H ; H
e e g NS AW Mult!ple environments are important for deS|gn|ng
Detector IDEAL IDEAL coatings whose performance must be controlled in
e | different conditions (e.g., different illuminations,
Active Material 3 different incident or exit mediums, different

g‘lrSt Surface Front Back | Ssubstrates, or different detectors). If a coating

contains layers whose refractive index changes due

to some outside influence (e.g., temperature, light
intensity, electric current, magnetic fields, moisture), then this window’s active materials may to used. Multiple
environments also may be used to design coatings for birefringent substrates — that is, substrates whose refractive
index depends on incident angle and polarization. As in the Environment dialog (page 10), for each environment,
you must specify:

* Incident medium is a name in the list of substrates. This name must be defined before it may be used. If it is an
absorbing material, TFCalc assumes k=0.

e llluminant is a name in the list of illuminants. This name must be defined before it may be used.

» Substrate is a name in the list of substrates. This name must be defined before it may be used. It is treated as a
massive (bulk) medium, which has no interference effect; only attenuation if it is an absorbing material.

* Thickness is the physical thickness of the substrate, given in millimeters.
» Exit medium is a name in the list of substrates. This name must be defined before it may be used.

» Detector is a name in the list of detectors. The name must be defined before it may be used. Specifying a
detector is useful when you are designing a filter for a detector, otherwise it is best to use IDEAL.

* Up to three active materials -- materials whose index changes due to an outside influence.

e The first surface encountered by the light: Front or Back. Generally, this is Front, meaning that light origingtes
in the incident medium. However, as shown in the window above, it is possible to define environments for Jight
originating on both sides of a coating.

When active materials are used, each environment represents a different setting of the outside influence. For
example, if the outside influence is temperature, then each environment could represent a different temperature.
Then, for each environment, the name of the active material changes. Be sure that at least one of the layers in the
current environment uses the active materials listed under the current environment column (marked with an
asterisk). If you change the current environment, then TFCalc will automatically substitute the active material into
the layers windows, maintaining the physical thickness of each layer.This will be done automatically during
optimization if you use multiple environments in the optimization targets.

When the Environments window is the top-most window, you may use the Options menu to add, delete, print, copy,
and append environments.
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Materials and SubstratesWindows

E[I= Materials

Al i

Substrates ==

BAFZ2 v =
BATIOZ LA
tDs ABSORP
CDSE Iy
CEF3 LR
CEOZ L
Eo AL203
ER AMTIR-1
CRYOLITE N
Esl BAFZ
cu BE
FE BKT
GAAS I
BAP BR-ZNSE

CAFZ

The windows above show how the names of the available materials and substrates are displayed. To see the data for
a particular material or substrate, click on the name. When one of these windows is the top-most window, the
Options menu may be used to add, delete, and print the names of materials and substrates.

Add Material...
Delete Material...

Print Materials...
fopi..
Hppend..

Print All Material Data...
#ipting 4
fption 3

When the “Add Material” option is selected, the following dialog appears:

() Table of n and k

— (& Dispersion Formula

Formula type for n: Sellmeier 1 -

Mol A N
nii)= +
(A "t s,

Formula type for k:

k(A)=10

[ ok ) [ cancel )

The new name must be entered. Refractive index data may be given as a table of data points or as a dispersion
formula. If the latter is selected, then the formula type must be selected for the n and k parts of the complex
refractive index. When OK is pressed, a blank table or formula will appear.



Section 2 Guide to TFCalc Page 27

An example of a table of refractive index data for a material is shown below.

S I&=————— Material: 512 =ic————"~—
Datum ] =] 7 g
wavelength 500.0 550.0 600.0 650.0
Index N 1.453 1.455 1.452

In

The optical data consists of up to 1001 points. When the program needs the value at a wavelength not in the table, it
uses linear interpolation to estimate the value; if the wavelength is outside the range of wavelengths, then the value
at the closest endpoint is used. The program keeps the data sorted by wavelength.

For all materials, the index N must be greater than zero. The extinction coefficient K is zero for non-absorbing
(dielectric) materials. For absorbing materials, K > 0. For material exhibiting optical gain, K < 0. Note that TFCaglc
must be setup to handle gain materials in the Configure dialog.

The dialog below shows an example of how a dispersion formula is edited.

Material: TEST

Wavelength range (pm): to

Ao:[1.0 | A1:[0.0 | A2:[0.0

?\‘3
B1:[1.0 | B2:[0.0 | B3:[0.0 |
............. I[UK]][PHM][EMUB”]
[ cancel | (Comment... | [ FitData... |

Dispersion formulas are valid only for a certain range of wavelengths. The range, along with the formula
parameters, is entered into the dialog. When the Print button is pressed, the dispersion formula parameters are
printed. When the Comment button is pressed, the user is able to edit the comment for this formula. When the
Convert button is pressed, the user may convert the dispersion formula to a table of data points. For materials (and
now substrates), the Fit Data button allows the user to find a dispersion formula that fits measured data. See
Appendix C (page 63) for more information.

When the user presses OK, extensive checks are applied to the dispersion formulas to insure that the formulas
compute a valid refractive index for the entire wavelength range.
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For the dispersion formulaxy, the following choices are available:

Name Dispersion Formula X
Sellmeier 1 AN
n(?&)= AD +2—
A
Sellmeier 2 AAE AW
B A Y
Tz — g
Sellmeier 2 &
nid)= Ay +— iy A
W _h,
Sellmeier 3 b0 A AN
nid)=(l1+—3 + 3 +
Aoy, AE_hy P4,
Cauchy n(?&):AU+%+%
Hartmann 1 () = &g+ 2
A= iy
Hartmann 2

_ A4
niM)=Ay+ (J\—Az)z

Schott Glass A, Ay kg By

nfA) = .JAU +A1.?&2 +?&_2+_+_+

A A
Drude 2.2
2 2on_ o, AAGN
0t -k (A=A Al
For the dispersion formulaX), there are four choices:
Name Dispersion Formula XY
Zero k()= 10
I 1
Sellmeier K- [n(?x)-[BmBT%i—S”
Exponential k()= Byexp (B, A1y
Drude & A
_ My
2n(Ak(h)= 1 Al

Note: the Schott Glass company now uses the Sellmeier 3 dispersion formula to characterize its glasses. However,
the Schott formula is still used by other glass manufacturers.

Note that the Drude formulas cannot be mixed with the other formulas; when you select Drudlg foen(TFCalc
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automatically selects Drude forM( Also note that n and k are given implicitly; TFCalc uses a procedure for
determining n and k separately. The Drude formulas are useful for modeling the dispersion of metals for
wavelengths in the infrared and far-infrared.

If the user changes the index of refraction of a material, the thickness of any layer using that material may be
affected. The program automatically adjusts the thickness; if you have given priority to optical thickness, then the
physical thickness will be recomputed, and vice versa.

When a window of material or substrate data is the top-most window, the Options menu may be used to add, delete,
and print the data. A short comment can be made about each material or substrate. There is also an option to read
material and substrate data (including internal transmittance data) from a text file created by the user. This optjon is
described in Appendix A (page 60). The user may also write the material data to a text file, making it easy to use this
data in other software.

Add Material Data...
Delete Material Data...

Print Material Data...
Edit Material Comment...
Append...

Read Material from File...
Write Material to File...
DOption 3

The data about each material and substrate is stored in a separate file. For example, there is a file called MGF2 in the
“Materials f” folder and a file called GLASS in the “Substrates f” folder. This feature makes it much easier to make

a copy of the data, to share the data with a colleague, or to move the data to the IBM-PC version of this software.
NOTE: if you rename or create new files, be sure that the file name consists of at most 10 characters. NOTE: if you
plan to use these files with the IBM-PC version of TFCalc, be sure to use at most 8 characters in the material and
substrate names.
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Hluminant Windows

ECE llluminants
A1

AMO
CIE-&
CIE-B
CIE-C
CIE-DS3
CIE-DES
CIE-D7?3S
K2800
K3600
TEST
TEST1
WHITE

The window above shows how the names of the available illuminants are displayed. When this window is the top-
most window, the Options menu may be used to add, delete, and print the names of illuminants.

Add Hluminant...
Delete Illuminant...

Print Illuminants...
FFEEEF IO
Gnpeng.

Print All Iluminant Data...
antion 2
Bakinn 3

To see the relative intensity of a particular illuminant, click on the name. The data for “WHITE” light is shown
below.

EC0=——— Illuminant; WHITE

Datum 1

wWavelength 550.0

Intensity (F) | 100.0000

2] E3E

Intensity is given as a percentage. Linear interpolation determines the intensity at wavelengths not given in the table;
for a wavelength outside the range of wavelengths, the value at the closest endpoint is used. There may be up to
1001 data points for each illuminant. With the “Save as Illluminant” command (page 57) in the Results menu, it is
possible to store the reflectance or transmittance of a thin film coating as an illuminant.
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When a window of illuminant data is the top-most window, the Options menu may be used to add, delete, and print
the data. A short comment can be made about each illuminant. There is also an option, described in Appendix A
(page 60), to read illuminant data from a text file. The user may also write the illuminant data to a text file, making it
easy to use this data in other software.

Add luminant Data...
Delete llluminant Data...

Print llluminant Data...
Edit llluminant Comment...

Read Illuminant from File...
Write Illuminant to File...
Normalize Hluminant

Create Blackbody llluminant...

Normalize llluminant is a command that scales the illuminant data so that the maximum intensity of the illuminant
is 100%.

Create Blackbody llluminant is a command that enables the user to create an illuminant having a blackbody
spectrum of a given temperature. The illuminant is normalized so that the highest intensity is 100%. The self-
explanatory dialog is shown below.

Temperature (K):

wWavelengths: [300.0 | to [1oc00 | by [100

The data about each illuminant is stored in a separate file. For example, there is a file called WHITE in the
“Illluminants f” folder. This feature makes it much easier to make a copy of the data, to share the data with a
colleague, or to move the data to the IBM-PC version of this software. NOTE: if you rename or create new files, be
sure that the file name consists of at most 10 characters. NOTE: if you plan to use these files with the IBM-PC
version of TFCalc, be sure to use at most 8 characters in the illuminant names.

An illuminant may be displayed as a curve by creating a coating file which uses the IDEAL detector, AIR as th
incident and exit media, AIR as the substrate, and which does not have any front or back layers. You must en'ier the
name of the illuminant in the Environment dialog and then analyze the coating. The Plot window will display the
illuminant curve.
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Detector Windows
E[[= Detectors ==
&1 ]
stk 5
)

The window above shows how the names of the available detectors are displayed. When the window is the top-most
window, the Options menu may be used to add, delete, and print the names of detectors.

Add Detector...
Delete Detector...

Print Detector Names...
{8,
fEppend..,

Print All Detector Data...
fppbing 2
G bing 3

To see the relative efficiency of a particular detector, click on the name. The data for the “IDEAL” detector is shown

below.

EN

Detector: IDEAL

Catum 1

wWavelength 550.0

Efficiency (F 100.0

&= B

Note that the efficiency is given as a percentage. The program uses linear interpolation to determine the efficiency at
wavelengths not given in the table; if the wavelength is outside the range of wavelengths, then the value at the
closest endpoint is used. There may be up to 1001 data points for each detector.



Section 2 Guide to TFCalc Page 33

When a window of detector data is the top-most window, the Options menu may be used to add, delete, and print the

data. A short comment can be made about each detector. There is also an option to read detector data from a text file
created by the user. This option is described in Appendix A (page 60). The user may also write the detector data to a

text file, making it easy to use this data in other software.

Add Detector Data...
Delete Detector Data...

Print Detector Data...
Edit Detector Comment...
Append...

Read Detector from File...
Write Detector to File...
Normalize Detector

Normalize Detectoris a command that scales the detector data so that the maximum efficiency of the detector is
100%.

The data about each detector is stored in a separate file. For example, there is a file called IDEAL in the “Detectors
f” folder. This feature makes it much easier to make a copy of the data, to share the data with a colleague, or to
move the data to the IBM-PC version of this software. NOTE: if you rename or create new files, be sure that the file
name consists of at most 10 characters. NOTE: if you plan to use these files with the IBM-PC version of TFCalc, be
sure to use at most 8 characters in the detector names.

A detector may be displayed as a curve by creating a coating file which uses the WHITE illuminant, AIR as the
incident and exit media, AIR as the substrate, and which does not have any front or back layers. You must enter the
name of the detector in the Environment dialog and then analyze the coating. The Plot window will display the
detector curve.
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Distrib ution Windows

ECE Distribution
DIODEN
DIODEZ

Bl

G

User-defined radiation distributions can be used in the Cone-Angle Average computation (see page 41 and pape 47).
The window above shows how the names of the available radiation distributions are displayed. When the windpw is
the top-most window, the Options menu may be used to add, delete, and print the names of distributions.

Add Distribution...
Delete Distribution...

Print Distribution Names...

Print All Distribution Data...

To see the relative intensity of a particular distribution, click on the name. The data for the “EQUAL” distributiof is

shown below.

EJ=——— Distribution: [QIUAL =—"———+
Daturm 1

Angle (deg) 0.0

Intensity (&) | 100.0000

@] [o

Note that the intensity is given as a percentage. The program uses linear interpolation to determine the intensify at

angles not given in the table; if the angle is outside the range of angles in the table, then the value at the closeft

endpoint is used. There may be up to 1001 data points for each distribution.
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When a window of distribution data is the top-most window, the Options menu may be used to add, delete, and print
the data. A short comment can be made about each distribution. There is also an option to read distribution daga
from a text file created by the user. This option is described in Appendix A (page 60). The user may also write fhe
distribution data to a text file, making it easy to use this data in other software.

Add Distribution Data...
Delete Distribution Data...

Print Distribution Data...
Edit Distribution Comment...

Read Distribution from File...
Write Distribution to File...
Normalize Distribution

Normalize distribution is a command that scales the distribution data so that the maximum intensity of the
distribution is 100%.

The data about each distribution is stored in a separate file. For example, there is a file called EQUAL in the
“Distributions f” folder. This feature makes it much easier to make a copy of the data, to share the data with a
colleague, or to move the data to the IBM-PC version of this software. NOTE: if you rename or create new fileg4, be
sure that the file name consists of at most 10 characters. NOTE: if you plan to use these files with the IBM-PC
version of TFCalc, be sure to use at most 8 characters in the distribution names.
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Run Menu
Analyze Only *A
Optimize Design #L
Global Search 06
Compute EFI *E

Compute Sensitivity

Compute Cone-Angle Average
Compute Monitor Curve M
Compute Layer Sensitivity...

Set Analysis Parameters...

S5et Optimization Parameters...
S5et Global 5earch Parameters...
Set EF1 Parameters...

Set Sensitivity Parameters...
Set Cone-Angle Parameters...

Set Monitoring Parameters... Use this menu either to analyze or to optimize your coating.

Note that each of the seven commands in the top half of the
menu has a corresponding “set parameters” command in the
bottom half of the menu. Below we briefly describe each
menu item.

Analyze Only commands the program to compute the reflectance, transmittance, absorptance, psi, density, loss, and
phase shift of the current coating; no layer’s thickness is changed. This command is useful when you modify some
parameters and want to see the effect. A small status dialog, as shown below, gives the progress of the analysis.
Note that you may quit the analysis at any time by selecting the Quit button.

Analyzing coating. Wavelength: S61.0

The results may be displayed by selecting “Show Plot” or “Show Table” from the Results menu. Use the “Set
Analysis Parameters” command (page 42) on this menu to specify the range of wavelengths or angles for which the
coating is analyzed.

Optimize Designtells the program to vary the thickness of the layers or the group factor of groups (and the index of
variable materials) so that the following merit function is minimized:

m

sz

j=1

IDC T
NToI

K o
U
U

where m is the number of targets, k is the power of the method, | is the intensity of the illuminant, D is the efficiency
of the detector, T is the desired target value, C is the computed value (of reflectance, transmittance, etc. at the target
wavelength, angle, and polarization), Tol is the tolerance for a target, and N is the normalization factor for the target.
Although this formula looks complex, in most cases, | =D = Tol =

For continuous targets, the summation above is replaced by a sum of integrals.
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The quantity
DG — T,

N;

is called the “deviation from target.” The purpose of the normalization factor N is to convert the units to a
compatible scale. The normalization factor for reflectance, transmittance, absorptance, and luminance targets is 1.0;
for phase targets it is 1.8; for density targets it is 0.09; and for color targets it is 0.01.

The number k, termed the power of the method, can have a significant effect on the optimization results. The
program allows the following values for k: 1, 2, 4, 8, 16, and Max. As the value of k is increased, the larger
deviations will be emphasized, forcing the optimization methods to equalize the deviations of the targets. Note: if
the gradient or variable metric optimization method is used, a power of 1 should be used only if the targets are at
their extreme values (e.g., reflectance 0 or 100%).

When k is set to Max, the merit function is defined to be the maximum of the deviations:

,D;C,—T,

F-
Max N, Tol.

]

Because this function is not smooth, only the Simplex method works when k = Max.

Use the “Set Optimization Parameters” command (page 43) on this menu to select whether layers or groups are to be
optimized, the optimization method to be used, the number of iterations, etc.

When layers are being optimized, only the layers (and variable materials) you have selected to be optimized will be
changed. If there are layers on both sides of the substrate, then layers on both sides are optimized simultaneously.

When groups are being optimized, only the groups (and variable materials) you have selected to be optimized will
be changed.

o - Inde:: Profile Layers: 8
10 -
Target Deviations

ns -
J|||.|||I.|I||||._.|||||I|...|I||||I|..||III||.. Al
10 20 30 40 S50 [n]

lteration: 41 Status:

Deviation: 0235 Stopping criteria met.

Change (&)  0.000

Physical Thickness (nm): S41.1

The figure above shows the status dialog that indicates the progress of the optimization. The dialog shows two
graphs. The top graph displays the number of layers, the total physical thickness of the layers and the index profile
— the index and relative thickness of each layer. The incident medium, the substrate, and the exit medium ar
shown as heavy horizontal lines. The bottom graph — the target deviations bar chart — shows the value of th
“deviation from target” for each discrete target. When continuous targets are used, then the bar chart becomes a
series of curves; one curve for each continuous target. Internally, TFCalc automatically converts each continuqus
target into a series of discrete targets; the total number of discrete targets is displayed on the chart. This resuliis
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illustrated below.

0 - Index Profile Layers: 8

I

1.0 -

Physical Thickness (nm) : 541 .4

04 - Target Deviations Targets: 893

0.0 -
1

lteration: 23 Status:
Deviation:  0.242 Stopping criteria met.
Change () 0.000

The bars and curves for average, P, and S polarization are displayed in different colors. Note that continuous targets
capture the fine detail in the behavior of the deviation. When both discrete and continuous targets are used, then you
will see a bar chart and the curves side-by-side. “Iteration” is the current iteration (or step) of the optimization
process. The number called “Deviation” is just the value of the merit function. “Change” indicates how much the
design has changed from the previous iteration; this quantity approaches zero as the optimization method converges
to the local minimum of the merit function.

Optimization continues until either the maximum number of iterations is attained, the solution is found, or the Quit
button is selected. After optimization stops, the Analyze and Continue buttons become highlighted. Selecting the
Continue button causes the optimization to continue. Selecting the Analyze button computes the reflectance,
transmittance, absorptance, psi, density, loss, and phase shift of the optimized coating. Note that you may quit the
optimization at any time by selecting the Quit button; the best design will be displayed. There is also a “delayed”
quit capability; if you are doing needle optimization, which involves a series of local optimizations, you may want to
quit after the current local optimization is complete. To do this, hold down the Control key while clicking the Quit
button. The button’s caption will change to “Quit*” to indicate that quitting will be delayed.
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Global Searchenables the designer to search for a global minimum rather than a local one. The “Set Global Search
Parameters” command (page 45) on this menu allows the user to control various aspects of the global search. While
global search is working, the following dialog is displayed:

Designs Generated: 100 Best Deviations
Designs Accepted: 100 1.260 ik
1.527
Possible Minimums: 9 1633
Status: 2271
3116
3309
913
3937
4243
Optimize Designs...
Save Best Designs...
Sing Seardiing
]

Designs Generated counts all designs generated, including those that have been excluded from the global search.
Designs Accepted counts only those designs that have been included in the global search. Possible Minimums
counts the number of possible minimums found; this number can increase and decrease as the global search
progresses. The list of Best Deviations shows the deviations of the designs that are possible minimums. Under Status
there is short message indicating what function is being performed. The global search can be stopped at any time by
clicking on the Stop Searching button.

At the end of the search (or after the Stop Searching button has been selected), the other buttons become active.
Select the Done button to exit from the global search dialog. Warning: pressing the Done button does not save any
of the designs found by global search.

Select the Save Best Designs button to save the designs that are possible local minimums. The designs will be saved
with names {prefix}001, {prefix}002, etc. The dialog shown below will appear.

Save Designs Having Deviations

Filename Prefix:
[#vz] |

L

=]

K ]] [ Cancel ]

If the Optimize Designs button is selected, the following dialog appears:

Mumber of [terations for each Design: _I

Optimize: @ All Designs () Possible Minimums Only

[[ oK ]] [ Cancel ] [l]ptimization Parameters]

This command gives the designer the capability of optimizing many designs simultaneously; either the gradient or
variable metric method can be used.
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Compute EFI commands the program to compute the (squared) electric field intensity within the coating. Use the
“Set EFI Parameters” command (page 46) on this menu to specify the wavelength and the layers you want to
analyze. While the EFI is computed, the dialog shown below is displayed. The computation may be halted by
selecting the Quit button.

Computing EFI. Percent done: 24

The results may be displayed by selecting “Show EFI Plot” from the Results menu.

Compute Sensitivitycommands the program to determine how sensitive the coating design is to small
manufacturing errors (also called tolerancing). Use the “Set Sensitivity Parameters” command (page 46) described
below to set the expected error and the number of trials you wish to perform. The program will vary the thicknesses
of layers randomly, analyze the coating design, and record the results. The sensitivity computation selects
thicknesses that are uniformly or normally distributed within the error range. While the sensitivity is computed, the
dialog shown below is displayed. The computation may be halted by selecting the Quit button.

Analyzing sensitivity. Wavelength: 5330

Trials: 16

The results may be displayed by selecting “Show Plot” from the Results menu. Shown below is an example of a plot
produced with this command.

S=——""——————"— Plot
Il Tuminant: HHITE Angle: 0.0 ¢deg>
Medium: AIR Reference: 1000.0 {nm?
Substrate: G Polarization: Aue
Exit: Remark: Sensitivity with 18 ertor

G
Detector: IDEAL

000 8500 9000 9500 10000 10500 11000 11500 12000

Feflectance () ws Havelength (rm2 E

The heavy center line represents the original coating design; the two outer-most lines above it and below it represent
the minimum and maximum (that is, the worst-case) variation as the layer thicknesses are varied randomly. When
the “quartile” sensitivity analysis is selected in the “Set Sensitivity Parameters” dialog, then three additional curves
are computed and displayed: the first, second, and third quartiles. The second quatrtile is the median performance
(which is usually very close to the performance of the coating design). The first and third quartile curves are usually
slightly below and above the median performance; at each wavelength, the performance of half of the random
designs lie between the first and third quartile curves.

This command computes the sensitivity of all quantities (reflectance, transmittance, absorptance, psi, density, loss,
and phase shift) at S, P, and average polarization. To see another quantity’s sensitivity, use the “Set Plot Parameters
command in the Results menu. If you find a coating design that is very sensitive to small errors, the design may be
improved by using the Minimize Sensitivity option in the “Set Optimization Parameters” dialog (page 43).



Section 2 Guide to TFCalc Page 41

Compute Cone-Angle Averageeommand is useful for analyzing a coating when the incident radiation is in the

form of a cone. Use the “Set Cone-Angle Parameters” dialog described on page 47 to specify the cone. The cone
axis may be normal or nonnormal to the coating. The coating is analyzed at a number of equally-spaced angles
specified by the user. The result (i.e., reflectance, transmittance, etc.) at each angle is weighted according to the
proportion of the radiation incident at that angle and the intensity of the radiation at each angle. While the cong-
angle average is computed, the dialog shown below is displayed. The computation may be halted by selecting the
Quit button.

Analyzing cone angles. ‘wWavelength: 5430

Angle: 37.00000

The result of this calculation may be displayed by selecting “Show Plot” or “Show Table” from the Results menu.

Note: this command computes the proportion of transmission or reflection due to each polarization. However,
because we are computing the average of a 3-dimensional bundle of rays, there is no actual P or S
polarization. It is best to look at just the average polarization.

Compute Monitor Curve command enables the user to simulate the output of a light monitor as one or more layers
are deposited on a monitor chip. Use the “Set Monitoring Parameters” command described on page 47 to select the
layers and the monitoring wavelength. While the curve is being computed, the dialog shown below is displayed. The
computation may be halted by selecting the Quit button. The results may be displayed by selecting “Show Monitor
Chart” from the Results menu.

Computing monitor. Percent done: 77

wavelength: 1

Compute Layer Sensitivitycommand lets the user determine which layers are most sensitive to manufacturing
errors. It is generally used only after a design has been completely optimized. It produces a bar chart like the one
shown here:

First-Order Layer Sensitivity (1 /nm)

4.0e-& =
-I_ —

| . l
4 0e-§ — ' ' ' ' ' ' '
1 2 £ 4 =] & T g
front lagers

Second-Order Layer Sensitivity (1 /nm)"2

0s -
1 z I 4 5 & 7 8

front lagers

[[ 0K ]] [ Save Results in File... ] [ Copy to Clipboard ]

To understand this graph, there are two cases to consider: (1) When computing the layer sensitivity of a completely
optimized design, the first-order sensitivity is very close to zero. In this case, the second-order sensitivity indicates
the steepness of the “valley” in which this design lies. If a layer has a large second-order sensitivity, it means that a
small change in that layer’s thickness will lead to a large increase in the value of the merit function. (2) When this
computation is applied to a non-optimized design, then the second-order sensitivity is undefined because the design
is not at the bottom of a “valley.” In this case, the first-order sensitivity shows how the merit function increases or
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decreases as thickness increases. The two buttons allow the user to save the numerical results to a file or to save the
chart to the clipboard.

Set Analysis Parametergnables you to enter the range of wavelengths and/or angles over which the coating
should be analyzed. The dialog is shown below.

@ Range of wavelengths {nm) 400.0 to |?00.0 | by |2 |
Incident angle {deg) 0.0

{3Range of incident angles (deg){0.0 to [30.0 | by [10 |
wavelength (nm)

(O Both, range of wavelengths at each angle

(3Both, range of angles at each wavelength

Choose between studying a coating design for a range of wavelengths (at the given angle), a range of angles (at the
given wavelength), or for a range of wavelengths and angles; click the desired button.

For a range of wavelengths: enter the first wavelength, the last wavelength, and the increment between wavelengths.
The coating design may be analyzed at up to 32000 wavelengths. The incident angle is measured from a normal to
the substrate.

For a range of angles: enter the first angle, the last angle, and the increment between angles. The coating design may
be analyzed at up to 32000 angles.

For ranges of both wavelengths and angles, enter data about both ranges. The product of the number of wavelengths
and the number of angles may not exceed 32000.
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Set Optimization Parametersenables you to select the number of iterations performed by the optimization method,
the accuracy to which it is to work, and the power in the merit function. The dialog is shown below.

Optimize: @ Layers ) Groups

Method: 1 Gradient O Simplex ) Dariable Metric
Power: D1 @2 04 08 016 O vias

Max. Iterations: |[ITCNEE

Error Tolerance: |1.0e-8

Mau. Change (%): |10.0

[JMinimize sensitivity (very slow)

[ Stop optimizing zero-thickness layers

[<] Display index profile while optimizing

[[ 0K ]] [ Needle Parameters ] [l:ancel]

There are three optimization methods available: Gradient, Variable Metric, and Simplex. The Gradient and Variable
Metric methods require the derivative of the merit function to be calculated; as the method approaches the
minimum, the derivative approaches zero and becomes less accurate. Hence the Gradient method will usually be
stopped by inaccuracies in the derivative. At that point, the Simplex method, which does not use derivatives, may be
used to improve the solution. These methods will find only a local minimum of the merit function.

Note that each iteration of the Gradient and Variable Metric methods will produce an improvement in the deviation;
this is not true for the Simplex method. Also, the Simplex method may need many more iterations to converge to a
solution. If N layers or groups are being refined, we suggest 5*N iterations for the Gradient and Variable Metric
methods and 10*N*N iterations for the Simplex method. Reducing the error tolerance will increase the number of
iterations needed to find a solution. In the above dialog, Max. Change is used only by the Simplex method, which
uses it to start its iterations. If you are near a minimum, it should be set to a small number (e.g., 1%).

The Variable Metric method usually locates a minimum faster than the Gradient method. However, the Gradient
method requires much less memory to operate, which may be an important consideration if many layers are being
optimized. Note that, if these methods are started far from a minimum, they may converge to different designs.

If the Minimize Sensitivity option is selected, the optimization method will use the parameters in the Set Sensitivity
Parameters dialog (see page 46) and attempt to minimize a merit function that allows random thickness variations.
For the best results, Number of Trials should be fairly large. However, a large number of trials also causes the
optimization to run more slowly.

Use the Stop Optimizing Zero-thickness Layers option if you want to eliminate a layer as soon as its thickness
becomes zero. If this option is not selected, then zero-thickness layers continue to be refined, possibly growing to a
useful thickness. However, it is often the case that very thin layers oscillate between zero and a small number, which
reduces the efficiency of the optimization method.

To watch the index profile during optimization, select the Display Index Profile While Optimizing check box.
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The Needle Parameters button leads to the dialog shown below, which controls the behavior of the “needle”
optimization method, which is described in Appendix B (page 61).

Needle Dptimization Parameters

[<] Add "needle" layers using the following materials:
Tin2 si02

[<] Continue adding layers until the optimal design is found

[1Add many layers simultaneously

[ Use local optimization before adding needles

[ o ( Tunneling Parameters | [ cancel |

If the Add “Needle” Layers box is checked, then the needle method will be used the next time the user optimizes the
design. If the Continue Adding Layers Until Optimal Design Is Found box is checked, then the needle method will

be used repeatedly until no more layers can be added. In this case, the design is said to be optimal. If the Add Many
Layers Simultaneously box is checked, then the needle method will attempt to add many zero-thickness layers
before the local optimization begins. This option works best when you know that a design (such as a bandpass or
edge filter) will require many layers. If you want to insure that the design is locally optimized before needles ar
added, the Use Local Optimization Before Adding Needles option can be selected. This option is useful after you
have manually stopped an optimization and then want to resume optimizing.

When the Continue Adding Layers box is checked, then the Tunneling Parameters button becomes enabled. When
pressed, this button leads to the following dialog:

Tunneling Parameters
After needle optimization finds an optimal coating design:
[<] Grow the coating
if its total thickness is less than nm
and if its deviation is greater than
[<] Save the design with a prefix of
|Test |

The tunneling method, described in more detail in Appendix B (page 62), searches for a better design after an
optimal solution has been found by the needle optimization method. The tunneling method is initiated only if (1) the
“Grow the coating” check box has been checked, (2) the total thickness of the coating is less than the amount given
in the dialog above, and (3) the deviation (i.e., the value of the merit function) is greater than the value given in the
dialog. Also note that there is an option to save each optimal design before it is changed by the tunneling method.
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Set Global Search Parametergnables the user to control the global search process. The dialog shown below will
appear.

Search by Yarying: @ Layers ) Groups
Tupe of Search: @ Random ) Systematic

Number of Designs to Search: (100 |

Number of Mearest Neighbors: 4

Maxirmum Change from Current Design (&):| 100.0

[ Exclude Designs Having a Thickness > | 1000.0 {nmj

[JExclude Designs Having a Deviation > | 100.0

Global searching works by generating many designs (either randomly or systematically) and determining which of
those designs may be near a local minimum of the merit function. The best local minimum is called the global
minimum.

The designs are generated by varying the layer thicknesses (or group factors) of the current design; only those layers
(or groups) that have been selected for optimization will be varied. If a design uses variable materials and they have
been selected for optimization, then those indices will be varied during global search also.

In the dialog above, use the Number of Designs to Search to specify how many designs to search; the maximum
number is 32767.

What range of designs will be generated by global search? That is determined by (1) which layers (or groups or
variable materials) have been marked for optimization in the current design and (2) the percentage in the Maximum
Change from Current Design field. If the maximum change is 50%, then the thickness (group factor or index) is
allowed to vary +50% from its current value. Thicknesses (and group factors and indices) are prevented from
becoming negative. If layer thickness (or group factor or index) constraints are being used, the global search will
stay within those constraints.

A systematic search is recommended only if a few layers (or groups or variable materials) are being optimized. The
systematic search generates designs that are uniformly spaced. For example, if the thicknesses of two layers are
being varied and 100 designs are being generated, then 10 equally-spaced thicknesses will be generated for each
layer; the result is 10 x 10 = 100 designs.

During a random search, designs are generated randomly; the thickness of each layer (or the group factor of each
group) being varied is picked from a uniform distribution. For example, if a layer being varied is 100 nm thick and
the design is being allowed to change by 50%, then random thicknesses will be picked to be between 50 and 150
nm.

Global search locates the best designs by creating a map of all the designs. For each new design the search
generates, it (1) uses the merit function to compute the deviation and (2) finds the other generated designs, called
neighbors, that are closest to it. If all of the design’s neighbors have larger deviations, then that new design is called
a possible local minimum. By changing the Number of Nearest Neighbors field in the dialog, the designer controls
how many of these local minimums will be found; if many neighbors are used, then fewer minimums will be found;

if only a few neighbors are used, then more (and possibly false) minimums will be found. In general, the number of
neighbors should be increased as more layers (or groups or variable materials) are being varied.

As designs are generated, it may be useful to exclude some of them from the global search. This exclusion is
accomplished by checking the Exclude Designs Having Thicknesses > or the Exclude Designs Having Deviation >
check boxes. The first excludes designs having a physical thickness greater than the specified number; the second
excludes designs that are far from a local minimum.
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Set EFI Parametersenables you to control the EFI computation. You may select the wavelength of interest, the
layers to be analyzed, the resolution, and whether the EFI should be computed in the incident medium and substrate.
In high-resolution mode, the EFI is computed at 400 points. For medium and low resolution, 200 and 100 points are
computed, respectively. The dialog is shown below.

wavelength {nm):
Layers: CAl I:I to

O Llow O Medium @ High

(] Compute Intensity in Incident Medium

Resolution:

[ Compute Intensity in Substrate

( ) (

0K Cancel

]

Set Sensitivity Parametersenables you to control the sensitivity computation. The dialog is shown below.

Layer Thickness Distribution:
@ Uniform ) Normal
[] bary Thickness by:

@ Relative (%) = | [N
r Absolute (nm) £ (5.0
» Absolute (qw) = (0.01

[ bary All Layers

Number of Trials:

[ Compute Color Sensitivity

Refractive Index Distribution:
@ Uniform ) Normal

[Jvary Index by:
Relative (%)

+

Analysis Type:
@ Worst-case (Monte Carlo)

3 Quartile (Monte Carlo)
) Worst-possible

Cancel

Note that errors in layer thickness and/or index may be simulated; check the “Vary Thickness by” box and/or the
“Vary Index by” box. The distribution of layer thicknesses and indices can be either uniform or normal (Gaussian).
The thickness of the layers may be varied either relatively or absolutely (by either physical or optical thickness);
click on the option you want and enter the desired error amount. The index error is always a relative amount. Select
the analysis type; worst-case analysis uses Monte Carlo simulation to estimate the minimum and maximum variation
of the coating’s performance; quartile analysis uses Monte Carlo simulation to estimate the quartiles of the
performance distribution (see page 40); the worst-possible analysis uses optimization to compute the worst possible
performance for a given manufacturing error. The number of trials is used only in the two Monte Carlo simulations.
In general, if a coating has more layers, it will take more trials for the sensitivity to converge to its minimum and
maximum values. If the Vary All Layers check box is checked, the thickness of every layer is varied; otherwise,

only those layers marked for optimization will be varied. If the Compute Color Sensitivity check box is selected,

then the color of each trial design will be plotted in the Color window.

Note: for the normal distribution, all generated thicknesses are within two standard deviations of the nominal
design. For the normal deviation, the numbers in the Relative and Absolute boxes are assumed to be the
standard deviation of the layer thicknesses.
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Set Cone-Angle Parametergnables you to specify the cone of radiation for the cone-angle average computation.
The dialog is shown below.

Current central angle (degl: 0.0

Cone's half-angle (deg): 10,0000
Cane's f/number: 2879
Murnber of angles (odd): l:l

Radiation distribution:
) Equal intensity
) Lambertian

@ User-defined: |TEST
1.4 Cancel

The cone's central angle (the angle the cone's axis makes with the normal to the coating) is always the incident angle
entered in the Environment dialog. The angular size of the cone may be entered as either the half-angle or the f/
number. To calculate the cone-angle average, the coating is analyzed at the number of angles entered in the last box.
This number must be odd. The computation becomes more accurate as this number increases; doubling the number
of angles reduces the error by a factor of four. The user can select from either two built-in radiation distribution

(equal intensity or Lambertian) or a user-defined distribution (see page 34). r

Set Monitoring Parameterscommand enables the user to specify the parameters used to compute the monitor
curve. The dialog shown below will be displayed.

) @ Reflectance O Transmittance
Monitor:

) Delta o Psi
Polarization: @ Average (] [ 3
Resolution: O Low O Medium @ High ) Nm:
wavelengths: |550.0 || || | nrm
Chip Substrate: |GLASS [J Reverse side of chip reflects

Chip Thickness: mm
Monitor Angle: deg

[[ 0K ]] [ Set Monitor Ratios ] [ Cancel ]

Either reflectance, transmittance, delta, or psi may be monitored. When monitoring reflectance or transmittance,
then either P, S, or average polarization may be monitored. The curve can be computed at either low, mediumj high,
or a specified (nm) resolution. Any number of layers can be monitored. The layers may be monitored at up to t|1ree
wavelengths. The chip substrate is a hame that must be in the list of substrates. If the back of the monitoring chip
reflects light, be sure to check the box. The thickness of the chip is important only if the chip absorbs. The monitor
angle is the angle at which the light monitor source strikes the chip.
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Each material may be a different monitor ratio, which may be changed by pressing the “Set Monitor Ratios” button.
The following dialog will appear:

Monitor / Rack Ratios
{2 Use the same ratio for all materials:
@ Use the following ratios:
TIO2 1.0
Sloz 1.1

The user may choose to give all the materials the same monitor ratio, or to give each material a diffefidrd ratio.
monitor ratio is proportional to the square of the ratio of the rack distance to the monitor distance.
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ResultsMenu

Show Tahle T
Show Plot ¥P
Show EFI Plot

Show Color Chart
Show Monitor Chart

Set Table Parameters...

Set Plot Parameters...

Set EFI Flot Parameters...

Set Color Chart Parameters...
Set Monitor Chart Farameters...

«Save Results #1
Save Results #2
Save Results #3
Save Results ¥4
Save Results #5
Remouve Saved Results

Use this menu to display the results produced by the Run
menu. Note that each of the five commands in the first part of
the menu have a corresponding “set parameters” command in
the second part of the menu. Below we describe each item.

Save as IHuminant...

Show Tabledisplays a table of the (1) reflectance,

transmittance, absorptance, psi, density, or loss or (2) phase
shift on reflection or transmission. For example, see the

figure below. The table may be printed via the Options menu. The number of decimal places may be controlled with
the “Configure” command in the Misc menu.

ECI=—— Table
Feflectance (8}
nm Aue
380.0 93,74
382.0 54.99
384.0 34,26
386.0 33.97
388.0 g2.92
390.0 32,33
392.0 31,80
394.0 I1.34
396.0 S0.94
392.0 0,61
400.0 50,33
402.0 0. 14
404.0 49,98
406.0 49,57
402.0 49,51
410.0 49,77
412.0 49,77
414.0 49,78
416.0 49.21
412.0 49.24

Note that the quantity displayed here is actually the modified reflectance, which is the product of reflectance, the
illuminant intensity, and the detector efficiency. To obtain the actual reflectance, transmittance, absorptance, loss,
and optical density, use the WHITE illuminant and the IDEAL detector. Psi and the phase shift due to reflection and
transmission are not affected by the illuminant or detector.

When a coating design is analyzed for ranges of angles and wavelengths, then this window displays tables at one
angle (or wavelength) at a time. Press the left and right arrow keys to display other angles (or wavelengths).

This window can be resized to show more or fewer lines of results. As a shortcut, you may double-click in this
window to bring up the Set Table Parameters dialog (see page 54). Note that when this window is top-most, the
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Options menu has commands to print the table, copy the table to the clipboard, save the table in a file, and to
calculate statistics.

fgdsd...
Gpipip..

Print Table...
I TIEE S
fppaad.,

Copy to Clipboard
Save Table in File...
Calculate Statistics...

When the Calculate Statistics option is selected, the dialog shown below appears.

Statistics for: Reflectance (%)

Polarization: (@ Average OP Os
Range: to |700.0 nm
Maximum: 50.83 at 4000

AYBrage: 50.03

Minimum: 4934 at 7000

When the user clicks in the Calculate button, it displays the minimum, maximum, and average of the parameter
being displayed in the Table window. The user may change the polarization and the wavelength range over which
the calculation is done. If the coating has been analyzed for ranges of wavelengths and angles, then this dialog will
display two additional text boxes for the range of angles.
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Show Plotdisplays a plot of the (1) reflectance, transmittance, absorptance, psi, density, or loss or (2) phase shift on
reflection or transmission. It is possible to overlay the plot of one parameter on another. Here is a plot of the optical
density and phase shift on transmission.

E(IEE=————————————— Plot
Il luminant: HHITE Angle: 0.0 tdeg>
Medium: AIR Reference: 550.0 <rm>
Substrate: GLASS Polarization: Aue P nnnnn
Exit: GLASS Remark: Fabry-Perot
Detector: IDEAL

r 360.00
o F315.00
s 270,00
F225.00
F180.00
F135.00
r 90.00

Fo43.00

t t t t 0.00
500 520 540 SE0 520 B00

Optical Density and Phase Shift on Tronsmission Cdeg) ws  Howvelength Crm) @

When a coating design is analyzed for ranges of angles and wavelengths, then this window displays plots at one
angle (or wavelength) at a time. Press the left and right arrow keys to display other angles (or wavelengths). To
display the performance curves for all angles (or wavelengths), hold down the Shift key press the left or right arrow
key. This Shift-key technique also works for printing and for copying to the clipboard.

When the substrate has a finite thickness, then the reflectance and transmittance calculations take into account the
reflections due to the back surface; an incoherent light source is assumed. By selecting the “Set Plot Parameters”
menu item described on page 55, it is easy to:

« Display the reflectance, transmittance, absorptance, psi, optical density, or loss.
» Display the phase shift on reflection or transmission.

» Display the Average, S, and P polarizations.

* Change the vertical and horizontal scale of the plot.

* Choose the horizontal axis units from the following: wavelength, relative wave number, wave number, electron
volts, or frequency.

» Display the optimization targets (discrete targets as small circles and continuous targets as thin trapezoids).
Average, P, and S polarization targets are displayed in different colors.

» Display up to five previously computed results on the same plot.

e Overlay one type of plot on another.

The “remark” on a plot comes from the first line of the Comment window; if the first line is blank, then no remark is
displayed.

Note: The phase-change and psi computations always assume the substrate has infinite thickness; reflections
due to the back surface are ignored.

As in the Table window, to obtain a plot of the actual reflectance, transmittance, absorptance, loss, and optical
density, use the WHITE illuminant and the IDEAL detector. Psi and the phase shift due to reflection and
transmission are not affected by the illuminant or detector.

As the cursor is moved across the plot window, the location of the cursor is displayed in the plot header. If the
mouse button is held down while the cursor is moved, the distance moved is displayed. If the shift key is held down
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when the mouse button is released, the statistics about the selected wavelength range will be displayed in a dialog. If
the Control key is held down while an area on the plot is selected by dragging the mouse, then that area will be
zoomed. You can unzoom by holding down the Control key and clicking in the plot. As a shortcut, you may double-
click in this window to bring up the Set Plot Parameters dialog (see page 55).

[ Options [

fsdst..
Geipie..

Print Plot...
{8,
fEppend..,

Copy to Clipboard
Calculate Statistics...
G bing 3

When the plot window is the top-most window on the screen, there are options to print the plot, copy it to the
clipboard, and calculate statistics. For information about the Calculate Statistics command, see the description of the
Show Table command on page 50.

Show EFI Plot displays the results of the electric field intensity computation. For example, see the plot below.

ETI=———————— [Fl Plot
Medium: AIR Angle: 0.0 (deg>
Substrate: GLASS Havelength: S50.0 (hm>
Exit: GLASS Polarization: P nnnnn
Femark: Phase Conjugate
o= s T e qeereegeqee e
20,04 AAb
25 04t R Y O O YN Y I I Y O O A R Y VY Y O I
PO O O Y O OO YN O O 9 I 1 & I O O O A R Y VY Y O I
1504
10,04 W I8 O R R Y ) I
SO f’k‘ \F
oo NENAN itk

25 26 24 22 X0 13 1614 12 0 & 6 4 Z 5
29 27 25 023 21 19 1?1313 118 73 03 1

Hormalized Electric Field Intensity (Squared) ,—
|

Note that the substrate, the medium, and the layers are identified. The relative physical thickness of the layers are
shown.The EFI computation always assumes the substrate has infinite thickness; reflections due to the back
surface are ignored.As a shortcut, you may double-click in this window to bring up the Set EFI Plot Parameters
dialog (see page 55).

As the cursor is moved across the EFI plot, the location of the cursor is displayed in the plot header. The x-
coordinate is the distance (in nm) from the top surface of the coating. If the mouse button is held down while the
cursor is moved, the distance moved is displayed. Using the Options menu, the plot may be printed or copied to the
clipboard, or the numerical results may be saved to a text file.
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Show Color Chart displays the color coordinates of light reflected or transmitted by the coating. It uses the results
of the last analysis and the spectral tristimulus values for the 1931 CIE standard observer (two or ten degree field,
depending on which value is selected in the Configure dialog) to calculate the color coordinates. The results of this
calculation are displayed as a 1931 CIE or 1976 CIE UCS chromaticity diagram or as LAB coordinates in a window
as shown below.

sNT=— Color Chart
0.9 Color Standard: 1921 CIE
Field of Uiew: z®
Folarization: Auvarage
0.8 Feference White: CIE-C
I Tuminant: WHITE
o7 Incident angle (degl: 0.00
Wellowish
Green Fefl  Trans
0.6 x Coordinate: 0.206 0.334
Green vellow Braznish Yellow u Coordinate: 0.079 0,334
\\ Green Dr;nge Yeallow Luminosity (8 0.10 92,90
0.5 i Dominant (rmd: MR 581
Reddizh Orange Complementary Cnm: 367 421
¥ \ \ \ A?grange Excitation Purity: 0.764 0,113

y

0.4 iBluizh “fellowish Pink
Greean

0.3
Red

I
kﬁreenish p?"m'
Elue £ o : " >/
. Purplizh Red
0.2

o E

eddizh
urple

o7}

o
o

Elue Pur
a1 ‘9‘?&

. 4
Purplish
Blue =} /
Q.0
0.0 0.1 0.2 (] 0.4 0.5 0.6 o7 0.8

: [

o

5

For best results, the coating should be analyzed from 380 nm to 780 nm (or wider) in 5 nm increments. The
excitation purity and the dominant and complementary wavelengths are also displayed. If the chart is displayed on a
color monitor, the approximate color of the reflected and/or transmitted light appears in two small squares. As a
shortcut, you may double-click in this window to bring up the Set Color Chart Parameters dialog (see page 56).

When a coating design is analyzed for ranges of angles, then this window displays the color at all angles (as shown
above). Press the left and right arrow keys to display the numerical values at each angle.

As the cursor is moved across the color chart, the location of the cursor is displayed. If the mouse button is held
down while the cursor is moved, the distance moved is displayed. If the Control key is held down while an area on
the chart is selected by dragging the mouse, then that area will be zoomed. You can unzoom by holding down the
Control key and clicking in the chart.

Using the Options menu, the chart may be printed or copied to the clipboard, or the color sensitivity results may be
saved to a text file. In the text file, the chromaticity coordinates (X,Y,Z) are written, tab-delimited, for reflectance
and/or transmittance (depending on what is displayed in the chart). The first line of the file contains the color of the
nominal design.
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Show Monitor Chart displays the monitoring curve produced by the Compute Monitor Curve command. The chart
displays either the reflectance, transmittance, delta, or psi as one or more layers of the design is deposited on the
monitoring chip. The top of the graph displays the layer number.

S [=—————=— Monitor Chart
Chip Substrate: GLASS Hovelength 1: S50.0 (rm) =—
Moni tor Ratio: 1.0
Moni tor Angle: 0.0 tdegl
Remark : Four-Lager Coating

[u] 20 40 &0 a0 100 120 140 160

Scaled Reflectance €82 ws Physical Thickness Cnm? E

As a shortcut, you may double-click in this window to bring up the Set Monitor Chart Parameters dialog (see
page 56).

As the cursor is moved across this chart, the location of the cursor is displayed in the chart header. If the mouse
button is held down while the cursor is moved, the distance moved is displayed. If the Control key is held down
while an area on the chart is selected by dragging the mouse, then that area will be zoomed. You can unzoom by
holding down the Control key and clicking in the chart.

Using the Options menu, the chart may be printed or copied to the clipboard, or the numerical results may be saved
to a text file.

Set Table Parameterscontrols what is displayed in the Table window. The dialog is shown below.

Display: [ Reflectance ~| O de
Polarization: [{ Average are s
[ S$how Saved Results: @1 &2 O3F O4 05

If dB is selected, then the parameter will be displayed in dB units; that is, 10 Log(x), where X is reflectance,
transmittance, etc. If previous results were saved, then those results may be displayed in the Table window by
clicking in the Show Saved Results check box. Note that this method may be used to display the results of the
sensitivity calculation (1 = worst-case minimum, 2 = worst-case maximum, 3 = first quartile, 4 = third quartile, and
5 = median performance).
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Set Plot Parameterscontrols what is displayed in the Plot window. The dialog is shown below.

Display: [ Reflectance «| [de
Polarization: [X] Average are Os
H-Axis Units: [ Wavelength ]
.............................. T
H-Axis Range: @ 9

©[380.0 | to [780.0  |nm

@ Automatic (426 to 4.26 %)

Minor Ticks: H:

[ o ) [ cancel | (overlay Parameters |

Most of the inputs are self-explanatory. To overlay two types of displays, click on the Display Overlay box. This

will enable the Overlay Parameters button. When the Overlay Parameters button is clicked, the parameters for the
overlay will be displayed and the name of the button will change to Primary Parameters. When the overlay
parameters are displayed, note that the plot type (wavelength or wave number) may not be changed. If the plot range
of the overlay is different from the primary plot, then the Plot window will have a second scale to the right of the

plot (as shown in the description of the Show Plot command). Minor Ticks refers to the number of extra grid lines
between the numbered grid lines.

Set EFI Plot Parameterscontrols how the EFI results are displayed. The dialog is shown below.

Polarization: [P s
) Automatic

Data Range:  0.00 to 1.00

[[ 1] 4 ]] [ Cancel ]
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Set Color Chart Parameterscontrols how the Color Chart is displayed. The dialog is shown below.

Display: [ Reflection [ Transmission

Polarization: @ Average (P s

@ CIE 1931 O CIE 1976
> Lab (CIE) 3 Lab (Hunter) (O Lab (Glasser)

@ Entire Chart
() Zoomed Chart

H-Axis: 0.0 to |0.8 ticks: [0
y-Axis 0.0 to |0.9 ticks: [0
Display Also: (< Color Names (€ ednr Sansitisity

Most of the inputs are self-explanatory. The Reference White, which must be a name in the illuminant list, is used to
compute the excitation purity and the dominant and complementary wavelengths. The Color Sensitivity check box
may be checked if color sensitivity was selected in the Sensitivity Parameters dialog.

Set Monitor Chart Parameters controls how the monitor chart is displayed. The dialog shown below will appear.

[ Scale the ¥-aHis so that monitoring begins at | 13.00

[ Display the material name for each layer

[] bisplay the monitor/rack ratio for each layer

@ Full Range (0.0 to 16574 nm)
O [o00 | to [16574 |mm

O Automatic (1662 to 97 .41 )

¥-Auis Range: @® ,ﬁ ta ,W‘ z

Minar Ticks: % |0 | v [o |

Most of the inputs are self-explanatory. Minor Ticks refers to the number of extra grid lines between the numbered
grid lines.

Save Results #hndSave Results #andSave Results #andSave Results #andSave Results #5ave the

results of the last analysis of the coating. These commands enable you compare these results with subsequent
calculations; just check the “Display saved results” box shown in the “Set Plot Parameters” dialog. When results are
saved, a check mark will appear in front of the selected command. NOTE: if TFCalc runs out of memory during a
computation, these saved results may be deleted.

Remove Saved Resultsliminates the saved results, which can occupy a large amount of memory, from the
computer’s memory.
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Save as llluminantenables you to save the reflectance or transmittance of a coating as an illuminant. The following
dialog is displayed:

Data to Save: @ Reflectance ) Transmittance
Polarization: @ Average P s
Juse Saved Results: w1 2 O3 04 Ob

Murminant Mame: HYZ

Choose the result to be saved and type the name you wish to give this new “illuminant.” If previous results were
saved, then those results may be saved by clicking in the Show Saved Results check box. Note that this method may
be used to save the results of the sensitivity calculation as an illuminant (1 = worst-case minimum, 2 = worst-case
maximum, 3 = first quartile, 4 = third quartile, and 5 = median performance).
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Miscellaneous Menu

Swap Front-Back Layers
ompute Doy from Bata Fie

Configure...
Window Options...

Use this menu for some miscellaneous commands. Below we briefly describe each menu item.

Swap Front-Back Layersswitches the front layers to the back and the back layers to the front. This command is
useful when you want to see how a filter behaves when light goes through it in the opposite direction. It is also

useful when you want to copy front layers from an existing coating to the back layers of the current design. Just
swap the front and back layers, copy the front layers from a file, and swap the front and back layers again. The same
procedure can be followed for using the stack formula to put layers on the back side of the substrate.

Compute Color from Data File command allows the user to compute the color of reflectance or transmittance data
read from a text file. The following dialog collects information about the data:

Data Kind: ) Reflection @ Transmission

Polarization: @ Average P [

@CIE 1931 (O CIE 1976
{3 Lab (CIE) O Lab (Hunter) (Lab (Glasser)

INuminant:

Reference White:

When the Get File button is pressed, the user will be asked for the name of the text file. The data file should consist
of two columns: wavelength and percent reflectance (or transmittance). The wavelengths must be equally-spaced
with an increment not exceeding 10 nm.

This command is available only when no coating design file is open. Be sure that the wavelength units in the text
file are the same as those in the Configure dialog.

Configure allows the user to (1) change the units used for wavelengths, (2) change the accuracy of the displayed
results, (3) indicate whether priority is given to optical or physical thickness, (4) change the phase shift convention,
(5) change the field of view of the color observer, (6) indicate how QWOT should be displayed in the Layers
windows, (7) indicate whether data tables should be extrapolated, and (8) indicate whether gain materials are
allowed. See the section about configuring TFCalc (section 1, page 6) for more details.
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Window Options command allows the user to indicate (1) that the size and position of windows should be saved by
TFCalc and (2) which windows TFCalc should open automatically when it opens a coating design file. The dialog is
shown here:

[<] Save the size and location of all windows

Select the windows which should be opened
automatically when a coating design file is opened:

[ Layers-Front [ Environments
[JLayers-Back [] Materials

[ Groups [ Substrates
[ variable Materials [ Muminants
[JTargets - Discrete [] Detectors
[Targets - Continuous [<] Plot

O Comments [ Table

If the Plot or Table window is selected, then the coating design is analyzed automatically before the window is
displayed.



Page 60 Guide to TFCalc Section 2

Appendix A: Reading Data from aText File

Itis possible to read material, substrate, illuminant, detector, and distribution data from text files produced in ofher

programs. This feature makes it easier to import data from other computers and to import data created from
formulas.

The file type of the file being read must be TEXT. Most text editors and spreadsheet programs are capable of
producing such files. Text editors usually call this a “text-only” file. Spreadsheet programs may call them “tab-
delimited” files.

Materials and Substrates.Each line of a file of index data must have a format such as

500.0 1.38 0.001

where the first number is the wavelength, the second is the index of refraction (n), and the third is the extinctio
coefficient (k) or the internal transmittance. If k is O, then it does not have to appear on the line. There may be

S
Ip to

1001 lines of index data; each wavelength should appear only once in the file. The wavelengths do not have to be

sorted. Sometimes you may have data for n at some wavelengths and data for k at other wavelengths. Just usg|
indicate the missing data and TFCalc will interpolate to find the n or k at the missing wavelengths. As example
the data

500.0 1.4 0.1
550.0 -1 0.2
600.0 1.6 -1
650.0 1.7 0.4
TFCalc would use interpolation to determine n at 550 and k at 600.

Illuminant and Detectors. Each line of illuminant or detector data must have a format such as

500.0 45.56

b -1 to
for

where the first number is the wavelength and the second is the intensity or efficiency (a number between 0 anq 100).

There may be up to 1001 lines of illuminant or detector data; each wavelength should appear only once in the
The wavelengths do not have to be sorted.

Distributions. Each line of distribution data must have a format such as
10.0 45.56
where the first number is the angle in degrees and the second is the intensity (a number between 0 and 100).

may be up to 1001 lines of distribution data; each angle should appear only once in the file. The angles do not
to be sorted.

file.

here
Jjhave

When a material, substrate, illuminant, detector, or distribution data window is the front-most window, the Opti¢n
menu displays an option to read the data from a file. The data in the file will replace all the data in the open window.
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Appendix B: Needle/Tunneling Optimization

The Needle Optimization method works by adding new zero-thickness layers into a coating design. After the new
zero-thickness layer has been added, one of the local optimization methods (gradient or variable metric) is used to
improve the new design. If the zero-thickness layer has been placed in the correct position, the local optimization
method will force the new layer to grow.

The needle optimization method, as implemented in TFCalc, works with up to eight materials. There must be at least
two materials. The coating design can contain layers of other materials, but only the eight materials are involved in
the needle optimization. The needle method examines the coating design and decides where to position the new
layer. It is also possible for the needle method to add no new layers.

Note that the needle method: (1) does not work with the Simplex method, (2) does not work with group
optimization, and (3) does not work with the sensitivity optimization.

Suggestions for Use:

» This method may improve existing designs, but it seems to work best when it either (1) starts with a single Jayer
or (2) is used in conjunction with the tunneling method.

e If starting with a single layer, the method seems to work best when the contrast between the substrate and layer
is greatest. For example, if SiO2 and TiO2 are coated on a glass substrate, make the starting design a single
layer of TiO2 (which has an index much higher than SiO2 and glass).

e The initial thickness of the single layer is very important. A thin single layer will lead to designs consisting of
only a few layers; a thick single layer can become a design with many layers. A good strategy is to try the
needle method on several single-layer designs of increasing thickness. Alternatively, the tunneling method (see
the next page) can be used to generate many optimal designs of increasing thickness.

e ltis a good idea to check the “Stop Optimizing Zero-Thickness Layers” box in the “Set Optimization
Parameters” dialog when the needle method is used.

* Use aliberal number of optimization targets. It slows down the optimization, but you are more likely to get the
design you want.

»  After optimization, the needle method may have left some very thin layers in the design. To remove them from
the design, set their thickness to zero and use the “Consolidate Layers” command on the Layer Window’s
Option menu. Then re-optimize the design (with needle optimization turned off).

For more suggestions, see section 3: TFCalc Optimization Guide.

1. For details see A.V. Tikhonravov, “Some theoretical aspects of thin-film optics and their applications,”
Applied Optics 32, 5417-5426 (1993).
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The Tunneling methodseeks to solve two difficulties in using the needle optimization method: (1) deciding what

the initial design should be and (2) deciding what to do if the design found by needle optimization is not good

enough. By solving these two problems, the tunneling method greatly simplifies the optimization process: now the
designer need only enter the optimization targets and a single thin layer; needle optimization and tunneling will
generate a sequence of designs whose performance approach the optimization targets more and more closely. In fact,
if inequality targets (see page 17) are used, then the needle/tunneling method will stop when all of the inequalities
have been attained.

Why is it called the “tunneling” method? You can imagine the optimization problem as finding the “valleys” of a
multi-dimensional function. This method seeks to find a tunnel from the current valley (i.e., the current optimal
design) to a better valley (where a better design may be found). The contour plot below shows this process for a
two-layer AR design.

W
pa: 0 @
fLs1e0
1 N ]

Thickness of H (QWOT)

The arrow shows that the tunneling method has decided to tunnel from one valley to another by growing the H layer.
After the new valley has been located, then local optimization is used to find the bottom of that valley. Then needle
optimization is used to add layers to the design. When needle optimization has found an optimal design, tunneling is
employed again.

Note that when an optimal design contains many layers, there are many possible tunnels to other valleys. The
tunneling method considers all the tunnels and selects (in some sense) the best one. There is no general rule that
describes which layer will be grown.
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Appendix C: Determining Refractive Index (N and K)

The problem of determining the refractive index of a thin film is difficult for several reasons:

e Athin film layer may be inhomogeneous.

e Thin film properties may change with time.

« Thin film properties may depend on how the layer was deposited.

» Reflectance and transmittance measurements are typically accurate to only +0.5%.

» If the thickness of the thin film layer is known imprecisely, there may be a number of different index-thickness
combinations that have similar reflectance/transmittance measurements.

In TFCalc, there are two methods of determining the reflective index of a layer:

» If ellipsometric measurements are available, or if you assume that the index is constant over a wavelength
range, then you can use a variable-index material (see page 24).

« Alternatively, you can fit a dispersion formula (see page 27) to measured data.

Using variable-index materials.In this case, TFCalc is used to find the design that matches the measured data.
Here is the procedure:

Create a new coating design file.
Set the incident and exit mediums and the substrate in the Environment dialog (see page 10).

Create a variable-index material (see page 24), and enter your best guess as to what N and K are. Also indicate
whether N and/or K is being optimized.

4. Add a layer to the Layers-Front window (see page 12) and change the material name to the name of the
variable-index material you created in step 3. Set the layer’s thickness to the estimated thickness of the thin film
that was measured. If the thin film’s thickness is not known accurately, set Optimize to Yes. It is also a good
idea to use the constraints so that the thickness stays within some limits.

5. Inthe Targets window (see page 17), enter the measurements taken from the thin film. If the measurements are
in a text file, you may use the “Read Wavelength Targets from File” option (page 19) or “Read Angle Targets
from File” option (page 19) to read that data into the Targets window. Note that measurements at any
combination of angle, wavelength, and polarization may be entered.

Before you optimize this design, save it to disk. Now you are ready to optimize the design.

If you think there is only one possible solution, then use the “Optimize Design” command (page 36) on the Run
menu. The local optimization method should converge to a solution fairly fast. You know that a valid solution
has been reached if all the deviations are small — on the same order as the error in the measured data.

8. If you believe that there may be multiple solutions, then use the “Global Search” command (page 39) on the
Run menu. You may want to change the global search parameters (page 45) to increase the number of designs
to search and to do a systematic search. After some possible global minimums have been found, use the
“Optimize Designs” button to converge to accurate solutions. Use the “Save Best Designs” button to save the
results of the global search.

Note that you can use this method with more than one layer also. However, for this method to converge to a valid
solution, the measured data must be quite accurate.
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Fitting a dispersion formula. In this case, the first step it to create a new material or substrate (see page 26) and to
select a type of formula that is appropriate. In most cases, the low-quality of the measured data dictates that the
simplest formulas — those with the fewest parameters — be used. Use a more complex dispersion formula if your
data is more accurate. When the dispersion formula dialog (see page 27) appears, enter some approximate values for
the parameters and then press the “Fit Data” button. The following dialog will appear for materials:

Information About Measured Data

Data file: 1 2 3
Measurement (T, R, B):

Incident angle (deq): [0 |

Polarization (Ave, P, 5): Ave

Back surface reflects? Yes

Name of data file: tran-0 click here click here
Wavelength unit: O R @nm O pm O wave number (1/cm)
Substrate thickness (mm): |1.0 Substrate name:
Est. layer thickness (nm): |100.0

Use every th data point
| compute... )] [ cancel ] [save Info...] [ GetSaved Info... |

(For fitting substrate data, the dialog is very similar; only the substrate name and the estimated layer thickness are
not used.) This is one of the most complex dialogs in TFCalc. Using this dialog, you enter information about the
measured data, which will be used to fit the dispersion formulas. Note that one, two, or three data files may be
specified. The top part of the dialog allows you to enter information about each data file:

Measurement (T, R, B).This is the kind of measurement that the data file contains. T stands for transmission, R for
reflectance, and B for reflectance from the back side of the substrate. If this input is blank, then the data file will not
be used. In the data files, all measurements must be given in percentages. Also, the same wavelengths must be used
in every data file.

Incident angle (deg).This is the angle of incidence at which the measurement was taken.

Polarization (Ave, P, S).This is the polarization of the measured data.

Back surface reflects?Sometimes the back surface of a substrate is coated to improve the measurement. For
example, for R measurements, the back surface is sometimes coated with a black paint so that there is no reflection

from the back surface.

Name of data file.You may select a data file by clicking the mouse in the box that says “click here.” After the file
has been selected, “click here” is replaced by the name of the file.

The bottom part of the dialog contains information common to the data files:
Wavelength unit. This is the wavelength unit that is used in the data files. Very important.
Substrate thickness.This is important only if the substrate absorbs.

Substrate name.This name must be in TFCalc’s Substrate list. The index data for the substrate must be accurate; an
inaccurate substrate index will lead to inaccurate results. (Not used in fitting substrate data.)

Est. layer thickness (nm).The estimated thickness of the thin film layer should be entered here. Because there may
be many solutions to this data fitting problem, the accuracy of the thickness is important. (Not used in fitting
substrate data.)
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Use every _th data pointQuite often there are too many data points in a data file created by a spectrophotometer.
This entry tells TFCalc to use a subset of data. Up to 1001 data points may be used from each data file.

Constraints. Press this button if you want to control which parameters should be optimized and to constrain those
parameters to a particular range of values. By default, the layer thickness is not varied; use this button to allow the
layer thickness to vary. When this button is pressed, a dialog similar to the one below will be shown; there will be a
line for each parameter in the dispersion formulas.

Parameter lalue Opt? Llimit? Min. Value = Max. lalue
Thickness: 100.0 0= 1.0e20
A0: 4.0 E E |o0.0 1.0e20
Al: 1.0 B K |o.0 1.0e20
A2: 1.0 B K |4.91e-1 1.0e20
[[ 0K ]] [ Cancel ] [ Restore Natural Constraints ]

For each parameter, select the “Opt?” check box if you want to optimize that parameter; select the “Limit?” check
box to constrain the parameter value between two limits; then enter the minimum and maximum values. For most of
the dispersion formulas, there are “natural” constraints, which TFCalc enforces so that division by zero does not
occur. Note that some of these natural constraints are determined by the current parameter values and by the range
over which the dispersion formula is being fitted. Press the Restore Natural Constraints button to replace the current
constraints with the natural ones.

Pressing the OK button returns to the previous dialog. After entering all this information it is a good idea to use the
“Save Info” button to save this information. Then, if you want to use this information again, use the “Get Saved
Info” button. Select the “Compute” button to start the data fitting calculation.
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As the data fitting calculation proceeds, the dialog shown below displays the progress. For each iteration of the
process, the dialog will change. The top part of the dialog contains the latest dispersion parameters.

Progress of Index Calculation

A0: 400075807 A1: 1.00260868 A2: 1.00087397

0.005 - Data File 1

oo

-0oo3 - ' ' ' ' ' '
3 0 13 20 23 0

Iteration: 9 Status:
Deviation: 0.003 Stopping criteria met.
Thick (nm): 100.000

The middle of the dialog shows a bar chart for each data file. Each bar shows the difference between the
measurement (T, R, or B) and the computed value using the latest dispersion parameters. The vertical axis has units
of percent. The numbers at the bottom of the bar chart are used to number the measurements.

The bottom of the dialog shows the current iteration, the deviation (in percent), the computed thickness of the thin
film layer, and a status message. As the fitting process continues, the deviation will decrease. At any time, you may
press the “Stop” button to stop the iterations; it will stop after the current iteration ends.

After the iterations are done (or if you have pressed the “Stop” button), the “Accept” and “Reject” buttons will
become active. If the “Reject” button is pressed, then the results will not be saved.

How does one decide whether the iterations have converged to a dispersion formula that accurately fits the measured
data? Let us suppose that the measurements are known to have an accuracy of £X%. Although X will depend on the
equipment used, values of 0.5% are probably typical. There are two indications that the iterations have converged to
an accurate dispersion formula: (1) the final deviation is less than X and (2) all the bars on the bar chart are in the

+X range. If the iterations do not converge to a dispersion formula that accurately fits the measured data, there may
be several reasons for this:

¢ The measurements are not accurate enough.
e The type of dispersion formula does not model the actual dispersion very well.
» The range of wavelengths is too wide.

* The initial dispersion formula parameters are not close enough to the actual parameters. It usually helps if the
parameter values are constrained to a range of values.

* The estimated thickness is not correct.

» The layer being measured is too thin. Experience indicates that it helps if the measured data has at least one
peak or valley; if the data is only increasing or only decreasing, then there are usually many parameter values
that fit the data.

« There is not enough information. For some materials, it helps if measurements can be made at different angles
and polarizations.
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